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O—REEBDHmEILNEEA TSI (Engraving Options)IZFEALE-ANFEL
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(Engraving Options) I CHRETEDINESIMEREEL TEALY,

O—FREDOTIFIEONBEERTSRHFEDNDI—REEEDITRTDAIUVREIVAD
BIZAEIT BHICIE, [HEATa> (Engraving Options)1DIa—KEES (Chord
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Appearances) o3> DOIRE (Edit)lR2>%9)yoL. IA—FREESOTAD

THORDTIILED5E (Project Default Chord Symbol Appearances)1¥ A7
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Project Dofault Chord Symbal Appearances
Enter a chord symbol: Editing: Am3({#11)

Fma(#11)

Project Default Appearances. -

GenajeLl)
Amafenl)*
Fma(eL1)

| SaveasDefault | | ResettoFactory | i apply | [ ctose |
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D& (Project Default Appearances)lIZlE. A IINRD T IAILEDHER
MEEEFSNO—FRENRREINET BRI EEZE (Single Overrides)liZ
X WELBEHNDOI—FEENRFTINET,

BEDI—FEETDTIHICDONEREERL. O—FEEBEERTHEZICEICRE
DHEBIZRTIEDIEEIE. FAT7ATDELIZHARYIRIZTO—FEEBEZANLT
EEL. [+ REvES)voT 2L a—FRENTTASIINDTIAILE DR
(Project Default Appearances)I®D') AMNIEBMEINET,

BERDI—FEEESDONEE LEZLI-HE. ERIZEEE (Single Overrides) 1D
Yrrmsa—rReEERL. B RevgsUvs35ieT HLLA—RRED
TIFHILMIEETEET,

[MERI=EEZE (Single Overrides)]) AFTaA—KREEEEEIRT L. L4705 D
BRIIO—FRENRTENFITH.HETHLETEERA. TADIMADOT
THILEONRICETITHRET BIZIE. 175 2L, FEE—FTa—FiEE%
BINDIVILET,

HRIER T BT O CHERTHI—RREOTIH/ILEDANERELT. TR
STHORDTIAILEDSER (Project Default Appearances))') ARDI—KREE%
BREITBIIZIX. FAT7OTDETIZHATIHILLELTRE (Save as Default) ]
REVEDI)VILET,

Tz OrERVWTCa—RREERELHEIC, URIREFLIT I74ILAEEICREL
WEEE TRELETIHILMEEICYEYh (Reset to Saved Defaults)1%4")
ILET . RELIEZT IHILARENZEWE S RAV T HEFOREICU Y
(Reset to Factory) JERTRENFET , CORIVEI)vITHE, 12— —MREFL
=TI+ ILEERED T R THIBRSNET,

[Ctrl] (Windows) F7=[& [Alt] (Mac) 9 &, A—FEEDTIHILEDNEZEHF
FLTWBIEE . [TI4ILLELTRTE (Save as Default) INTRELI=T 74 ILE
SREZLHIE (Remove Saved Defaults)lI2ZbHYET, RkIZ. [RELI-T 4L
FEREIZY+EYh (Reset to Saved Defaults)I7R2 AT HHEFEFD R E () Yk
(Reset to Factory)lI[CZEHYET,

I—FREBOTIHIONEERET HBE Y. BHOI—FESELEETS
BEIE. FA4T7OTOERINSI—FEEERELET . IRIEITOLTIE. UTFICEH
BALET.,
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ERDI—FEESDNEDOESE: BERDI—FESDONERERET DICIE, FET
—RIZYYBER T, a—FESEF TLVIVILES . RIRENHZ (7O T, 3—
FEESOBERERDMUE LY A XEMPARTEES,

L ] Edit Chord Symbol Appearance

Editing: Cdim7add#7

Zoom:—{ ]} Select: | Previous || Men |
(o] o o] ] dim dim dim
Xoffset: | 0.88 F: 1 Reset Xoffset | Scale: 100.00 ﬂ % Reset Scale |

[ cancet | oK |

TIZHBIRTAFT—ZERATHE. MET) 7N TR EIEMH/NTEET . mETL)
TTIX. O—FREEDRERER (AL IL—F L—OBERES. 94 T1—.
BRE.ANLAL—230E) 09I LTEIRTEES, [FiI~ (Previous) /TR A
(Next)JRZ 0 [<][~] F—ZERALTEREZEFTTHILLTEET,

BRERTEIRTDHE. IVDRTOIVYIRRSYILEZY. X #78Yk (X offset)]
©IY #27tyb (Y offset) ITIRIELIZY. [Alt] ZHHLAALRENF—ZHLIZYT
BT . ERICHAIEREREOBAUEF AR TEET . YA XALREERHETHL.
BRL-BREZROBAIZHIERDBETHEITEFELTIESW, Thid. &S
T+ NEERTARICEYGEL AT O EMET 520 BRAERINEHELTLDS
1=HTY,

F=. [R7—JU (Scale) IDEZAES 50 BRL-BHREZRORRDA LIZK
RENDNUFIVERTVT FTHIET, BEROBERAF A XZRETEFT,

FAT7ATDTEICHIRBERDOINMDEBRERE V)V ITHILT E
RUE-ERZHEBMOHAMMDESR (;-EAIE . maj7 & ARE) ITESH#ASHT
EHTEEY .
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BERIOI—FEEDNEE LEETHHEE. [TASTIDI—FREEONED T
#JLk (Project Default Chord Symbol Appearance) % 47 045 ®0l&EA TS
a2 (Engraving Options)ITTabndiREN LEZLI-a—FESICEELLGL
O A—FREEDITRTCOBHEBERNMEHINE T HILMEBLEZEBRERY®

EEEL-O—FESTERALTVWAERERICE. RBERDIIO LEHIZHN=

ARLRRINET, BREDTADIIMAT, EOTI—FESICHFEHRAINTUVEL
BRERICIFBIBRTAAVHARRINET . COT/AVEI)vITHE. TAdy

EOLERERMHIBRENET

7aScHrOa—FREDNEDTIAILE (Project Default Chord Symbol
Appearance) ¥ M(7BJ T. EEDERER (maj7 %5&) DT I+ILEDNEZE
RAEDTODIIMIHEITRTOI—FEEICHLTEALIZWMEES . EREDH D
BRERO—ENBREREZERL. RET7VEVVILTRELET . B
BRIIHTIERRFZDEREF DI R TOI—FESICRBENET,

REICEEIN=/\NtE—CORENDI—FESICHLTERYT LE . WEDER
BERTHLEITHLWMERERZER T D5 E(E. [+] RIVEDVILTERLIE
RERZLEITHLWMERERZHERLE Y  FRLE-EBRERE. BERRLTW

HA—FEBICOAERASINET,

L ] Edit Composite Companent

Mame: | comp.chordsymbol kadd. 7. kSharp

m Text Graphic Composite

Font: | Bravura

~]

Range: [ Standard accidentals (12-EDO) ~ |

B
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Zoom:—{_} Select: Ple\uous] \zm] | Delete Setected ]
Xoffset: |1.28 1 Xscale: |100.00 F Artachment from: | Baseline Right ~
Yoffiet: 013 | ¥scale: 10000 |  Attachmentto: | Basaline Left w

)

‘Add Glyph
Cancel | [T

ERDERERERET HBE. AVEA—F—ITAVA—ILENTLDHLP S
TAUEABT)TEEBMLIZY, XFNEBMLIZYTEEY . £ V57190%
BINYHIELTEFET (COBE. HRILEY T ST70v0BRICTIRKR—ILT=
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YFBEEDNERAREICHED LS, SVG BRDT STy FERTIIEES
TIHLET ) SIZ, Dorico DRDZFATEHLNATWSEBREDREED—HZE.
HoWAHAEHE THEATEET,

AREAT7OJ TEML-EREROEMELER, TT45—DTEIZH A ERT
(Attachment from)1&ME#E S (Attachment to)IA=2—TIRELFET . 1=&%

L. BRERODATOAZTIANDELDAIZ-DIFTT. X 7Y (X
offset)1&TY A THyk (Y offset) 12 E€0IZT 5L BREZDATOALETY
ADELEDANEFKELET . TFRNOYTUIEERT 56, SEBNGET I+
IWNMIBZHERT S5-I TR—R5/42F (Baseline Right)lIZiEEL=ZBID
BRERDERHSE. [R—RXS5A4VE (Baseline Left)JIZIEEL=-HABIDE
BRERDERZHDITERETEEEETITOHLET,
WELEZO—FESONERE) Ly SFEE—FTHRELEO—FESE. [HELFT
aY (Engraving Options) IOREDETE THEL-T 74 ILEDONERIZET (I,
O—FEESEFRL. [HREEdiY)] » THERZEU Y (Reset Appearance) JZ:&EIRL
£,

—BLOEROLIZO—FESERT: AHRETIE. I—FREERTI DL
SN TWDAVRMYIILAVIEIBRE T HTL—V—DFERD LICO—FESHAE
ReSNFET, I—FRRBEEDERICERTTHIMNE, HEE—FDIFL—F—
(Players) 1/ SR ILIZHBDTL—NY—h—KREHV)vHL, AV TFRAIAZ2—DIO
—FES (Chord Symbols)IH T A=a—moATLavEBIRT S ETHETE
FI L. .E7/HEAFEOFEEGE—EORO7TIE. FHEEBEDKE (12b
OO ETEINERTRICHEZEE) [Thinbnd, —FBLDERO EICO—KREE
BERTTHIENEFELWMEENHYET . 2D, I—FEBZHEDTL—
Y—miERND L (Above specific players’ staves)IIZRTRT DD (TIAHIH).
AR O—FELOERD L (Above top staff of system)JIZRRT I ELYE
ZoNBATLavM . TLLFIrATL 3> (Layout Options) DI 53R S ER
(Staves and Systems)IXR—IIZEMENFE L=,

O—REESDHEH: D—FEESDNROLEEZZEZHRF (Keep chord symbol
appearance overrides)1DA T a h TREE (Write)l » TR
(Transpose)lITBMEINEL Tz, CDATLavIEk, TIHILETIEA TITHE-TLY
FYNMRE LEELO—FESEBFATELGN O, LEELENREZRET
M )Y Ca—REEBZ EREICBRAT EMERIRTEET,

BRa5A4 - R DORLO—FEE S O EfR: Dorico TIE, A2a—FDHMNELD
—EDI—FESITHLTH YA FIYRTIDI—FEESD—HZIERTRIZTHES.
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O—REESMNIERTRICHELO>TLWSIMNIEBL. Ava—RDHERTIT HEERNIZH D
FERTOI—REEHERINET [IL—+BLVIFT+—%EBT (Hide root
and quality) 17 0/\T 4% BGAER EOI—FESTLICRETELLIITHYE
L7,

A—FREDHAR: LATIMADTL—V—ITHLT, R LEITO—FREEERTL
BOESBRELTWSGE, —FLOERD EICHIFARTEINDLIITAYELT,

O—RESDER: MHERICET MO T AT LERRIZ, FERHNTY)vILIZY,
[Shift] LGNSy LIZYLTH, a—FREEZERTEELGYELz, O—F
eI, SEREIRE(ITHRE (Edit)] » TTFRTREIR (Select All)JITREIRTEFE
T, BERY. BRGERNE(TEENITILI) T TEET,)

Lz EEER

FRIOD /MO BERGASERS . BEXEBES. BLUEFHDEBES DR—
WAy IIZ FILWERAI+ bR 2L DOIRBICET 5EFRTFANRIA U
(Dynamic music text font) JZERATEAKIITHYELIZ, ShIZKY A D E
EEATAUREFRIIC, SRFIEEBTDIAVNEERTEET,

Yool Hr

Dorico IZH> T ILTADIIMNEMENFE LIz, 7TV 7r—2a 2D TEET S
&. Steinberg Hub D/ RO DRAFEALI-TO VO —EIZ. Y2770
IR FRENFT . RAFALETOC IO —EICH T TAS I IR TS
NEWEEIE. LTOBICHI YT ILTAD IR TIZEL,

e Windows: C: ¥Users¥Public¥Documents¥Dorico Example Projects
® Mac: /Users/Shared/Dorico Example Projects

78—

MIDI 45 MusicXML 774 ILHSNTA—NEHAHA: FARILEFIEFELLLY MIDI
5 MusicXML Z7A4 IS 0—%5RMHAATEGE . TI4ILEDTFlow 1] TlE%EL,
BEAHRAATEITZAILDI7ZAINRZELEICHRIO—D R/ LA FONET,

J0—fFBDBE: HEE—FDOIT7AO— (Flows)l/3RIILTIO—%:EIRT 5L, 70
—D%E 1 MEIZBETHEIITHYEL,

6 ~R— Steinberg Media Technologies GmbH



Dorico N\—2 3V B

O steinberg

MIDI 274 ILDERHIAH

o MIDI F7MIDHEHAHAFEIZ, TURARVINHRZARENDELSIZHYEL=,

o MIDI 274ILHDLSYIEBRARBICIVELTTHEE. TOXEBOREL—B
LB TIRIREN D ESIZHBYZFEL=, (Bl: A DUV TIFEL B DY
1) 2vRk)

RY LR

MRDOBIRB XU THEICTXFRAMERERTT HIHEE DKIF/I/INXF: (Case
for full text at start and end of line)1A%, I§&4FS 3> (Engraving
Options)IDIRA LR (Pedal Lines)IR—2IZH 5. [TFHAL> (Design)lts
2arDIFaANARF)L (Una Corda Pedal) 17 IL—T 2 BIISNEL =, Ch
[SEY. DFEDRTIVEDRIBME LR THEIZHDVFAILTELVUIL O
WEDTHFRANMIHL, HEHED 1 XFEHEZAXF. XED 1 XFEDHKRX
FLFEREITRTUNMNCFTOYBZDIENTELLIITRYELT,

TILh—k: THE4& (Play)) » TEB&£A T3> (Playback Options)1DIM443>4
(Timings)IR—Y T IILA— DT I+ IO BERRZERETESLIITHYEL
f=o

RRICTUREZER: EREMLETUROELICHLT, ITREHETUR % (Final
tempo %) 1T A/NRTAZERETEDLIINRYEL Iz, COTANTATIE. TUHRD
EEEZEETEEFY,

E—HER

HED—BTOEERDOTICVE—MENZRT: HLLA T arnll BETFOH
RO TIZEMT)E—MENZERT (Additionally show repeat endings

below bottom staff) IABIMENELIz, COFTLavEAUIZTHE,

TLA47 47 ay (Layout Options) 1 DIg&k B (Staves and

Systems) IN—U THREL-ZOMDEREE—MENAHEED—F LDFE
[CRRENDLETTHELVE—MENIAN BN —BFTORERDOTICRRINET,

ERIENDOVE—FERDRE: VE—MEMDREFINNRRISERSNGNES

[CERETEDLIIGYFEL - &AL 1 EEE 3 @ET 1 HEMEERLT. 2
EIED# 2 BFENZERL.3 BEORDODYTRAITADHRD/A—tATr TS

BEHE.1 BEIMICIL3.1ERTL. 2 BREIMT21ERTTEEY,
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[Shift]+[T] ZRTERTEINDRYTA—/N—IZTUREE (: g = 100-120) A
NTEZLSITHY ., BEMICERGT U REENRRSINDLSITHEYELT,

EEARDAR— VYT

TE—DBREDIL—LMZOLEVMEZBA-IGEICHERERZD (Justify
staves when frame with single system is above this threshold)iAs, TL
A7 IhATL 3> (Layout Options) IDTEEARDAR—L Y (Vertical
Spacing)IR—>IZH HMimMiZ (EEHR) (Vertical Justification)14' )L
—JIzEmanEL,

A= RANSROTEE FEAEDEEN 1 R—UHT=Y 1 BEORXO7 D5
&, HEEDORDGEAR—ZANGELGEE LS HEBEADERDEE A R OMFEMF
FHIZDLELRHYET . LHOL. MERDERNES IL—TRE FEALE DI
BN 1 R—UH-Y 2 BUEHEIR—L 1 BOAHDR—UNREET DL
SEAATDIFE . RN—UHEREMEBOBEREERIZS (Justify distance
between staves and systems when page is at least n% full) JTIgELT=L
EMEZHBZLHEAHY ., ERODEEARDMERNEI—IZHEoTNER—IL
B TWAR—IUNFELTHRBRICRZDIELNHYFET,

1 R=TUHEYDHEDLN 1 BOR—TL 2 BUEDOAR—UHNRETHAIT7THE
ELTWS5E. . TE—DOBRMOIL—LNZOLEVMEZ BRI IGEICHRERAD
(Justify staves when frame with single system is above this threshold)J#+~
2AVEFIICTHE,. TODIIMNEELTCEE AMORRES —HIREBIZTEET,
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Issues resolved
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ID # Component Issue
STEAM-6465 Audlio export  The choice between exporting in WAV or MP3 format has been reinstated.
STEAM-6619 Audio export  Only those flows selected for export in the Audio Export dialog will now be exported.
STEAM-6455 Brackets and ~ When using the Wind band bracketing approach, system objects now once again appear
braces only above the first bracket for a given family.
Chord Chord symbols are no longer incorrectly transposed by edits made in Write » Add Notes
STEAM-6407
symbols Above or Below.
Chord Polychords with stacked alterations on both the upper and lower chord now show the
STEAM-6425 .
symbols correct stack of alterations on both chords.
Chord symbols now correctly appear selected after creation via the popover, and after
STEAM-6434 Chord . . . . . .
operations like moving a multiple selection. Other instances of the same chord symbol on
STEAM-6507 symbols ] o ]
other staves are also now drawn in blue to indicate that they are linked.
Chord Chord symbols are now correctly auditioned when selected, provided the chord track is
STEAM-6459 ) X
symbols routed to an appropriate output in Play mode (Mac only).
. The behavior of dragging dynamics to grace note positions in Write mode has been
STEAM-6262 Dynamics )
improved.
. Dragging the start handle of a hairpin in Write mode now correctly adjusts the duration of
STEAM-6408 Dynamics - . o
the hairpin, rather than moving the entire item.
. When pasting dynamics at the same rhythmic position as dynamics on another staff, they
STEAM-6409 Dynamics : . ) . . .
will now only be linked if their properties are equivalent.
. Setting the aperture of a hairpin to 0 could under rare circumstances cause a crash. This
STEAM-6435 Dynamics
problem has now been resolved.
. It is now possible to create a hairpin by clicking and dragging it when it starts at the same
STEAM-6438 Dynamics . o . .
position as an existing immediate dynamic.
Pasting part of a dynamic group no longer incorrectly offsets the position of subsequent
STEAM-6487 Dynamics g P . y group g y P q
dynamics in other groups.
. Adjusting the prefix or suffix of an immediate dynamic now updates the rhythmic spacing
STEAM-6569 Dynamics . .
immediately.
STEAM-6663 Dynamics Cutting part of a dynamic group to the clipboard no longer pastes in the wrong position.
STEAM-6685 Engrave If a ste.zm is dragged to the opposite side of the note in Engrave mode, when you stop
mode dragging, the handle now draws at the end of the stem.
Using Split Flow or Duplicate Flow in a project with one or more empty-handed players
STEAM-6530 Flows (i.e. players with no instruments assigned) will no longer cause the project to be corrupted
and unable to be reopened.
Multiple flows with the same name can now be exported correctly via the Export Flows
STEAM-6628 Flows

dialog.
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ID # Component Issue
STEAM-6652 Flows Split Flow now works correctly for music that includes notes crossed to different staves.
Exporting flows is now more resilient to invalid characters in the names of flows and layouts
STEAM-6662 Flows ] i
in the project.
Dynamics of force (e.g. sffz) are now correctly imported when importing a flow from
STEAM-6682 Flows . .
another Dorico project.
STEAM-6512 Instrument Under rare circumstances, the letter case of instrument change labels could change
changes unpredictably when opening the project. This problem has now been resolved.
Key . i i )
STEAM-5938 . Tonality systems saved as defaults for new projects now work correctly in new projects.
signatures
Key . . . . .
STEAM-6448 ) Edits made in the Edit Tonality Systems dialog are now properly undoable.
signatures
STEAM-6453 Key Signposts for Eey signatures ?n trans.posing inst.ruments that .don’t show key signatures
signatures now correctly include the accidental in the key signature root if necessary.
Key Key signatures in user-defined tonality systems that do not use any accidentals now show
STEAM-6629 ) i
signatures a signpost that reads Custom.
o The names of accidentals in the Interval Calculator in Write » Transpose are now
STEAM-6446 Localization
correctly translated.
r A number of inconsistencies between the default key commands in the localized versions
STEAM-6462 Localization )
of Dorico have been resolved.
Multi-bar . . - e
STEAM-6440 ; Multi-bar rests are once again correctly split in layouts with instrument changes.
rests
Multi-bar Multi-bar rests at the end of the system will no longer cause grace notes at the start of the
STEAM-6480 .
rests next system to be drawn incorrectly.
STEAM-6486 Multi-bar System objects (such as tempo and rehearsal marks) no longer have a different horizontal
rests position relative to the start of the bar when coinciding with the start of a multi-bar rest.
MusicXML Dorico will no longer crash when attempting to import a MusicXML file with an incorrectly
STEAM-6443 i . . .
import positioned time signature.
MusicXML Dorico can now correctly open MusicXML files (and files of other types) whose extensions
STEAM-6659 ) )
import are not in lower case.
MusicXML Chord symbols in MusicXML files whose position is specified using the offset element are
STEAM-6675 ) . N
import now imported at the correct positions.
Note )
STEAM-6488 . A syncopated pattern of short-n x long-short notes can now span an entire bar of 12/8.
grouping
STEAM-5102 Note input The behavior of deleting bars when tuplets cross barlines has been improved.
STEAM-6431 When inputting using a MIDI keyboard and the option to allow Dorico to retrospectively
Note input change the spelling of notes is set, the produced spellings have been improved in a
STEAM-6432

number of situations.
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ID # Component Issue
Certain edits, such as pasting or changing voice, that involved setting two or more
STEAM-6437 Note input properties on a note would not always cause the display of the score to be updated
correctly until another edit was made. This problem has now been resolved.
Copying and pasting ornaments and playing techniques from one project to another now
STEAM-6495  Note input Pying anc pasting paying feennid one prel
always ensures that the pasted ornaments and playing techniques appear correctly.
. When starting a new voice, the choice of octave now always uses the clef's hot spot to
STEAM-6525 Note input ) . . .
determine the octave of the new note, rather than the octave of the previously active voice.
. Note spacing adjustments made in Engrave mode on columns that do not contain notes,
STEAM-6496 Note spacing e )
e.g. for a hairpin that does not start at the start of a note, are now applied correctly.
Rhythm dots on stem-down split stem cluster chords no longer sometimes collide with the
STEAM-6454 Notes
noteheads.
When multiple rhythm dots have to be shifted vertically in multi-voice situations, dots are
STEAM-6587 Notes ) ) . . . . - .
no longer shifted if they can stay in their default position without colliding with another dot.
Clicking Save as Default in the Notation Options and Layout Options dialogs now
STEAM-6447 Options correctly updates the respective options for newly-created flows and layouts in the current
project, as well as new projects.
Lock System and Lock Frame now work correctly once again when invoked with a
STEAM-6151 Page layout . . .
selection of a single item.
. Different types of pedal lines (e.g. sustain and una corda) at the same rhythmic positions
STEAM-6414 Pedal lines )
are now spaced independently.
. Pedal lines now draw correctly when one staff of a grand staff instrument is hidden
STEAM-6617 Pedal lines o
because it is empty.
Projects containing many chord symbols should both open more quickly and respond to
Performance certain large edits (such as changing Layout Options or Engraving Options) more
quickly.
STEAM-6456 Performance Edit » Select All is no longer very slow when View » Attachment Lines is switched on.
STEAM-6464 Performance  The speed of opening projects has been improved.
A note selected in Write mode is now immediately editable when switching to Play mode,
STEAM-6415 Play mode . . .
rather than requiring you to first reselect it.
The chord symbol track and playing technique lanes no longer disappear when expandin
STEAM-6436  Play mode Y and praying feehniq ger disapp panding
and collapsing tracks in Play mode.
Adding an accent to a note played pizzicato will no longer cause that note to be played
STEAM-6444 Playback
back arco.
Successive grace notes of the same pitch now play back correctly, without cutting each
STEAM-6457 Playback
other off.
Using undo after changing the settings in Playback Options no longer sometimes causes
STEAM-6458 Playback

a crash.
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ID # Component Issue
Some of the GM patches in HALion Sonic SE 2 were set to use the wrong VST
STEAM-6463 Playback ) .
Expression Map by default and would not play back. This problem has been resolved.
STEAM-6586 Plavback Relative and gradual tempo changes now correctly take into account the beat unit of the
aybac
STEAM-6645 4 prevailing tempo.
Instruments that use note velocity for dynamics now correctly respond to changes to the
STEAM-6604 Playback . ) . .
Dynamic curve setting on the Dynamics page of Playback Options.
Repeat Dorico no longer crashes when you create a repeat ending that crosses one or more
STEAM-6450 . )
endings instrument changes.
Repeat The last segment of a repeat ending line with the Open, short appearance now correctly
STEAM-6489 . o )
endings obeys the end X offset specified in Properties.
R t It is now possible to set properties on segments of repeat ending lines that span
STEAM-6676 ' oo _ P Prop 9 P 9 P
endings instrument changes.
Double whole note (breve) rests are now correctly positioned relative to a single-line
STEAM-6365 Rests i
percussion staff.
Setting the Hide time signature property now applies to all layouts. This will not affect
STEAM-6485 Time existing projects in which the property is already set: select the time signature and use Edit
signatures > Reset Appearance to unset the property, and then set it again to make it take effect in
all layouts.
Choosing the light weight for tuplet numbers on the Tuplets page of Engraving Options
STEAM-6473 Tuplets g 9 g P P pag g avp
once again produces the expected numbers, rather than apparently random characters.
. Under some circumstances, opening a project that was saved using one of the zoom levels
STEAM-5825 User interface i . o ) ) )
that fits the page width or height in the viewport could crash. This has now been fixed.
STEAM-6442 User interface  Clicking outside a popover now correctly dismisses the popover once more.
’ The Save as Default button in Layout Options is now correctly enabled only when the
STEAM-6523 User interface ) . .
right kind of layout is selected, and only one such layout is selected.
The page margin controls no longer incorrectly disappear when returning to the Page
STEAM-6536 User interface Pag 9 9 d . PP . 9 N
Setup page from another page of the Layout Options dialog.
) Under some circumstances, closing a document window via the close button in the title
STEAM-6625 User interface . )
bar when a popover is open could cause a crash. This problem has been resolved.
Vertical The distances between systems no longer change unexpectedly for systems that contain
STEAM-6502 . .
spacing staves with instrument changes.
Vertical A problem whereby systems could be unevenly justified, causing them to end up too close
ertica
STEAM-6513 i to the system above or below, has been resolved. The appearance of projects affected by
spacing

this problem will be changed when opening them in Dorico 1.1.10.

Dorico Version History
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@ steinberg

HTRAE

Dorico N\—2 3V B

2017 &£ 6 H
CON—Da DHREREBREADEEELTIZESHELET,

2—FES

O—RESDER: 2—FREBEZERTHICIE. RDI—REEBERTTHEM
F-I3AKRFEZIRLT. TEEE (Write)] » Ta—K5E8% 4 (Create Chord
Symbol)1%E R I Bh ., F—R—Ka—rhybk ([Shift]+[Q]) ZFEHT S . §
HE—FoEAOY—LRyoRT B Koz vsLET,

O—RERESDORYTFH—N—AFHEFET, ST AVE1—8—DF—R—F&EA
LCEAYT H53—FESEANTHH . MIDI F—R—FE2ERLTI—FREEEE
%Li?o

AVEaA—4—DF—R—rEERAL-O—FESDOA N I—FESE. JL—k, FF
)T4— B (AT av). FaL—ay (F7vay), 8&UFrva—Fk (FTY
V) THEENTOET UTOLIIC, BEREFRYTA—/N—TANTEET,

e JL—b: EHFERED/—r42& (fl: C. Db, F#.B). kA YEERELD/—r& (Hl:
C. Des. Fis. H). BIEFDYVILIz—a (Bl: do. reb. so#, ti), R —ILT 445
J—%FRbHTFvaEILFnR— (Bl C AT v—DIBE. 1. 2b, 4#. 7).

o JFT4— RIAZHEETIESIE. L—LOHEIZABLADLELD., Tmajl.
TMIFE=IEImalZ ADLET BIRAZIEET HEESE. Tml. TminlFE =& mil
EANLET, T43ZyladBEIENdim), TdilFEflElol, A—F a1 A D
BZBEElaugl. Taul. TaglF &M+l N—D0T42=va DB EIE
Mhalf-dim]. Thalfdim jE7=1&lhdl. 6/9 DIFEXI6/9]1. [691F=IEM% 1% A
ALFET,

o TR IHRTUIAVPOASYy— Tth HNFWV-a—KZEAALES (Bl 27,19
BEN [FENEFTTADY— Tth LBIRENET), £z, AD0v— 7th 282D
IHRTOLIUAMFNzO—RFBEAATEET (Hl: maj9. Imaj7 &),

o FILAL—av: FIIEL—ar (Bl #5,09 HE), THOEM (Bl add#11.
addF#), AR ay (Bl susd), BB (Bl omit3. no7 %E) #AHALFET,
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o A a—F: L—ERILAHETIEETEERT . A DI—FEEBDHEITHIT D5
Bl TEEZFEALTRYIYET (fl: Cm7b5/Eb) ,

O—RREESZ2ERTREZITRY T —N\—TEHERTIEHNT LKL S L. =B
[CRREINDI—FESONBICITEEZELEFRA NEIE . TREL TSIV
(Engraving Options)1MIa—KES (Chord Symbols)IR—CDF T3>

THRETEET . LXK C ADy—a—FZANTSHE. CI1HICmajih
[CMIZARNTBELFET . WTIDIFZEL, ERICR RTINSO —FES DI
[FRLCTI, a—KI(&. &EA T3> (Engraving Options) I TEHRELT-5 8
TRIRINFET,

Dorico [&.1 DDa—KREEEIZ 2 DOI—FFEBICEEET SRJa—FIZE
HIELTWET  RYUI—FEERTDBZEE L. RyTFH—/—T 2 DOa—F%
INATZ42 (|) TRY>TAALES  F2EZE D AVv—3—FIT C7 3
—FEENRDHFEX.IDICTIEANLETS,

O—KR7%ALIES (N.C) ZANTBHAIE. RyTA—/S—IZIN.C.1. TNC1. no
chordlFEf=l&MnonelEAALET , L—FDHTHEBINI-O—REEEA TS
BEIE, RyTA—"—IZ, t=&z(EMCbass IF=IEGonly JEAHILET,

MIDI F—HR—RZFEALIO—RFEBDAN: I—RFRBEDRYTFH—/\—H L
TW3BE ., MIDI F—R—FTa—FE&ERLT, 3—FEBZANTEFT . F—7RK
—RCEEL-ENEHEIRTEAERICETEA T av (&, T5ei# (Write)] » TEH
AHBATL 3> (Note Input Options)1DIaA—KEH (Chord Symbols) IR—2 (2
RIRSNFT, F= BESN-O—FOERIPBEZETAEN, BIZIL—IRIT3
VTEBEINIZ&IITO—REREITANEN, BRELETARNED (FzEAE.C L E
FEELEBEIC, TCIEIETComith) I LT RED), BEFDEMPH AR
2AVIFEDFSITREITAREN L— A VI FEDOERLTERARBTORERICE
SRHGTREN BEDFTLavhBHYFET, MEAREITTATOLI—HF—(THEE
FTEHEDITTIEEVDT, CNEDF TP avEEEICKRATIDENHYET,

Foa—FTA—FRBZANTBICE, TOAIA—FE—HIZO—FEERLET,
T A—FEZDA L IA—FERNRISERT HELTEFS . EJ . 3—FDF
—ZHLET . EOF—EWLLFEER. A3 FEERLET,

ANT B FDIL—IEEHTDEEIEL. &ZAIHE 1 KTIL—FEERLFET R
2. ZEDIL—bDF—ZHLFFE BRYDEFEERLES . FE. I—FDIART
DEFZERFFISERLIZOBLIZ, FEeX—MolL. L— I EBEERLET.
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RY)A—KRZEADTBIZIE. FADFET 1 D2HDI—FEERLET, RIZ. 1
DOHDNIA—FEEELIE-FE.E5FFDFT 2 DODI—FFEELFET,

IW—rDHTEESNIZO—RETEARNTDICE. 1 DOEFLTEERL
FI,

I—RREANBOFES —>ay: a—RREORYTA—N—rENTINDESE
[=. [Space] #WTERYTH—N—FROMBITEHET, T, UTOF—HK—
RS a—bhyhEERLTRY TH—N—%88T 521 TEET,

e [Ctrl]+[<]/[—] (Windows) Et=I% [command]+[<]/[—~] (Mac): B/ RDI—K
REICBRILET,

e [Tab]: RO/NEIDFBMKEICHEELET

e [Shift]+[Tab]: BID/NEIDBIIAMIEICFEEILET,

e [Space]: RDMMIZFHEELET,

e [Shift]+[Space]: RIDMIZFEEILET,

o [<)[~]: F/IRDEBFIAFEIEIVXLTVYRCLEDELLAEWNAIZHEE)
LET,

e [Backspace]: BIDI—KREEIZHBELET,

MIDI ¥F—HR—F&EALTI—FETEANTIIHE . MHRETIE,. I—FEES
Lizdh&. RyTA—N—ZBEBTROAIEAET . [FEHEA DA T3> (Note
Input Options)IMTMIDI AA (MIDI Input) JR—L T, TMIDI F—HR—FIz&k3a
—FEESANPDHEHA A (Advance during chord symbol input via MIDI
keyboard)1#ERd 5L, COEMEEERTEFET,

EHIZMIDI F— R—FDEEDF—F I RIVEEERT HE. SESFLHTES —
LAVBEERB TEDLSITHYES  TREBRE (Preferences) IO F—R—FY
a—khvk (Key Commands)JXR—I T, IMIDI Learn J/RZEFERL T, HEDF
—ZIFEFDAA (Note Input )] » TA—FEREDANLEZEDH S (Advance
Chord Symbol Input)Ja<oRIZEIY LB TET,

BFEOI—FEESOHRE: BIFOI—FRESERmEITHICE. 3—FEESERRLT

[Return] Z#Y A\, BEEE—FTIA—FEBTEF TNV ILES , RyTFH—1\—
AFE ., RS TRRSN TSI LS EHRELET . AL SERET 5

EIZEO T BIFEDI— B ERETEET . Ry T —N—&DUFLTHLLI—
FEEBSEINTANT SN MIDI F—R—FTH L I—FESEERLET,
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O—FEES 0 N (Write)] » T8 (Transpose)1&EALT. ZIRLI-
1 DFRIFEROI—FEEEBATEES, - BRAEBO LIZR TSN, TR
& (Edit)] » TBEAEYF (Transposed Pitch)INBIRESh TL5154 ., 3—F&2
SE#ENEBHAEYFTRRINET .

O—FESNERRIBORIENDER: BHRALATIT,. BREFOI—FESTDOR
MEETMZLIEEE. BEDI—FREOHRELRILLSICO—FEEBEH/ELET .
22X, 9A)T4—, BR.ANEL—30%FZF (2 Dbmajl3 DJ)L—k~%EIDby
MolCHIZEETBE RLBADA VALY IILAV LT RTIZH LT, a—FESD
REMVEEINFT,

BEDAVALYILAVRDA—REBIZHL T, ZE2RBDOREEDELTHERT D
BEIX. BERYI—FESEZHRELT. I—FESDORYTA—/3—T [Alt]+[9]
EHLET . TRTHELRBFORITDEBEFREZT 56X, Ry T4+ —/\—T
[Shift]+[Alt]+[S] Z#LET,

A—FESERTT HERDER MHRETE. —FESEIVXLEIa00
AVRLYILAVE (F—R—F, FE— R—XX42—713 L) BT HERDLIZEKT
SNFET, COREE. REE—FDITL—F— (Players)I/\RIILTEEBETEET,
TL—Y—%#IRLTEY)vYL. [O—FEEE (Chord Symbols)]arTFRARAZ
1—FRAEFET [FTRTOLURIYILAVMIFEKT (Show For All Instruments)].
MYZXLEHavDAU RS ILAUMZERE (Show For Rhythm Section
Instruments) ], FzEXMFTRTHDAVRbSILAVMZIER TR (Hide For All
Instruments) JZ:&RLET,

FEBEICGLT . E7/GEDRERICAVSGERDER . [BELF T Ay

(Engraving Options)1MIa—F&EH& (Chord Symbols)|R—I T, LB

(Position) 17 IL—7 DI KERERANSEBRTOI—FEEOEE (Position of
o

chord symbols on grand staff instruments) |47 av %% ELT. 2 DD
REICO—FEBZERRTEEY,

A—FREERTITHLATIIOZFER: HHARETIE, I—FESETILRITLA
T IOREN—FLAT IO AIZRRENET  LATINEERETHEEIE. BEFE
E—RIZHPYEZ . [FL—— (Players) [/SRILTEZUTHTL—V—%EIRLT
A9y oL. [a—LRiEH (Chord Symbols) AV TFRAMAZ 1 —%FEFT . 2
JLARaAF7 E/R—KZEKR (Show in Full Score and Parts) ], [ZJLRAAT7IZDHF
7= (Show in Full Score Only)]. £f=IEI/S—MZDH#FKF (Show in Parts
Only)1Z#ZRLET,

12 R— Steinberg Media Technologies GmbH



Dorico /N\— 3V ERE

O steinberg

BEROI—FEEDFERT: BEDLAFTILT, HIHOI—FEEEERTIZTS
(2. 3—FESEFIRL T, TO/T4/ R DMa—FEHF (Chord Symbols)14
IW—TTIIERTR (Hidden) 1T O/NRTAZEHRELETS . A—FEBFDOODOYIZTHARH
RERSNFT, HMFERTSEEBEVEE X TEa— (View)) » THAF
(Signposts)] » Tla—F&8 (Chord Symbols)1&427IZLET,

O—FRBDEE: O—FESE. I—FESEHTAAET. RVDFHITLDE
BEOFEODRICEESN. KFEARICHRFZSINET, [HEELFTay
(Engraving Options)1®OTa—K&EHS (Chord Symbols)IXR—I T, IKKERE
(Horizontal Position)JZ&%ELT. 3—FiE 5% XUDFEEIS LD FEED FFEE
DEBIZREL, EFETRRIDLIITEIRTEEY (F-. BHETERTTHIL
LTEFEI N BE.AFRICTEEOMIKKLLGYET), £ B4 Da3—FEEHIC
LT, F7ANTANA\RILDOIO—FEEE (Chord Symbols)17 /L—7 T, [BRE
(Alignment)I7ANTADEREINTLSZEIE. TO/NT1 NRILOFRENEELES
nFEJ,

MR ETIE, a—FESFHEBRDEBICALETCRLEEMEBIZEIESNET,
f=f2l. BO—FESZERO LICHILTEESEVMES (L. [REFTay
(Engraving Options)JMTa—K&ES (Chord Symbols)IR—C T, THEERIEIZ
AhETI—FEEZEN (Align chord symbols across width of system)]
=ADIZLFET,

I—FEEEDBE): LEE—FT. a—FiEEERFFYT T 5h. [Alt]+[<]/[—] TO
—REEEZRBETHE. FHLWVMIBICO—FEEBABYET, O—KREEE2BENDD
—REEBLRICMBICEET HE. TOMEBIZHABEFENDI—REENHIBRENE
#-O

HFEETFT.3—FRBERIVILEY, [Alt]+[<]/[>] Ta—FESEPLTD
BELEYLTH, O—FESDREREESNFEEA,

A—FREBSONEDT vk O—FRBONBRIZTKSADKRERAUNAH ST
& . Dorico TIISEIFLRIEHRAUZHONLDHHRFEL. FIRTESLSITLTLE
T RROFEFFERATEILE. BRDHRAHCENBREFERTEHIEELTEET,
T)tybkiE, I#EA T3> (Engraving Options)IDOIa—KiES (Chord
Symbols)IR— D EEIZHYFET , TV EYMMILTDREY T,
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Bbmaj7(s)/F BbMM(?&)/F

Boston Brandt-Roemer
BhALYF Bbar () F
Indiana Japanese
ﬂll #11
ﬂ 57 b7A
F

4

Jazz Standard Nashville

BbMaj7:s/F Bbmaj7 '
New York F

Ross

fhizE. TF24ILk (Default) 1EFFIENZT)ybhREShTWWET, 2OT UL
YRTIX, ADY— Tth, A—F 2 AV, T4y, BLUVN—TT4E=vad
ERZET. ZEDRHEEHEMATHE. TELRYEBBREEHRT L%
HELTz, —BORESAFERAINTUWET, COTUYr I FHRITOD /O
JBEELLTGERINET,

T)tybi, la—K&EH (Chord Symbols)IR— T EIRBEOMHA A HEER
RTE. SIS, INoDEIRFREFAICELETHRETEET,

O—FEBICERATEIAVIDER: a—FREICHERTITIANRATAVNEE
B9 5I2I%. T%F (Engrave)] » 742 hRB4)JL (Font Styles)1%:ERL T,
[3—REE8 D74k (Chord symbols font)1&#w&ELET . [I—FEEE DT ET
FAMAETAE (Chord symbols music text font) (&, #¥)#5%E Tl Bravura
Text/[CERESNTOWET M, COTAVMNEIRELLBWNCEEZETTHLET, 74>
FREAIVIE THRRAM =IO T T)/r—av THERASNS SMUFL EHT+
FIHERETEET , O—FREBEAVI—FRERYSEDIZ, A5y 205400
HYIZ. XFF on 2RTT B4 T avEFRALTWSIES. [a—FiES &4
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—FORYYRAXFEI+>k (Chord symbols altered bass separator font) 1% #&
KLT. COXFAFERTETAERETEET S

O—REEOHYE: O—FRESEHRETIITE. BEE—FIZBHL. /XU TAR
TLADLEBIZHHI—FovIERRALET  ERATHBET/NAR (VST A1V
ARYILAURERIE MIDI T/AMR) ZFBIRL. RE—H—FAIVEFUICLT B
HEHYMILET 1 DOI—FEBLEZORDI—REELDFERISTL—
VERFL. RBGKAELL T O—FREBSIBESINFET, MIDI F—FR—F%{F
ALTI—FRBZANLEGEE. O—FRESANIERSN RIS T EA
LTa—rZEBEELET,

MusicXML DFHHAHAFA: a—FEE (&, MusicXML 77 ILMSERARAL ZEMNT
&% 9, f=1=L. kind E3RIZ Neapolitan, Italian, French, German, Pedal,
Tristan, H&XUY Other DEMNFZEINTSIGEE. I—FRESICHETEIENE
HETD=HDERASLEN =D, CNHDI—REEEHFEAHAAHBFIZERINET,

MIDI RTYTANEBORERFTDRT

BELARBORILEIE. I2EAIE. HDEE FH ERFETHIN.Gb ERFETHHE
EBE.RBEDQADFOLEEEHARICHELT IHEENEYFD 1 DOFERD
TH=OHITRIRT 5/~ R LE/FEEENDETT , MIDI F—R—FEFERLTERE
ANTBGE . FRLEZVWREZERIEE TELLV8H., Dorico (FEELTILTY
ALZEFERALTREDRBILEERLTLET,

ZOF7INTYXLTIE, BEDHAS. fIERDEFEIFa—FOFRE. 2—FDEF
ARDOERNEBEINET, £1=. ([FEFH (Write)] » TEEH#Z (Respell)] »
[E/FD/—rR2EFERLTEFEEZTHZ (Respell Using Note Name
Above/Below)1Z AL T) BFREZEZTMASHIHFSE. Dorico [FEDFRELEEIC
AN ZBTEIEVFOMDBFICHLTEZETIRENEATEDLIICLET,

Dorico TIEBIL T, S LRI, BERMN LA OB EIEIy—TE#, FENTH

STGBIETIVNEERALTERARESNFE T EFORELTRELT.L 2D

RETIYEREEEMENDSIIIHNIE (F=EAX. [T422yia 4thITIEE
KIADv— 3rd1% L), 2ARMICKYERGEENFENDSSITHYET,

Tz, RERICAWSESR (E7/RQE) ITARNTHERIEX OERIZEICA NS
NTVWBEEDIVTFAMEFERALEY , ;=&AL Dorico TIE BE. TA# T
BB b IEREENETH. COTHNET/DERIDEBRICANESNTNT. &
BIDERDEZATAMEIZIFH INEFENLTVSEE. BRAIDERDOERILIAH]
ERFEINFT . CHITKY. 2 DOEEFDEFOERNIYERISREINETS,
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MIDI F—R—FrZERALTERZANT HE FIOFEFEFa—FNEBNIZE
DY ANERITEIIENTEET 2EZIEL. C ADY—T TEJIZHITTIGH# |
EZAALIZIGE .2 DODBEFIEIGH IERINFETH, RICTGHIZAATHE. O
DTFAMNTOLDENESILSGHUIKIAD IICEZFMAONET , AALIE
BEIHDIF->TEBLEVESIZTBICIE. TEHFANFT T (Note Input
Options)1MIMIDI AA (MIDI Input) IR—2 T, TIEHDREESHDIZ->TH
EhEAR 93 (Allow spelling of notes to be adjusted retrospectively) 14212
LTLZaLy,

E7/ORSILE

HoPBEEER YT T DR TH, Dorico [F. E7/DREIJLERICHLT, &
HEENLEYR—FERHBELTOET 1 BORFIILIERTREILDEIELEZD
BERFIDYRATAUORFTIIVEREEICKY ., YRTAURT )L, DFANERS
W IARTRXR—IRE VO REBRITERTEES,

YORIZEDBRTIILERDER: EREEE—R T, EEBE (Playing Techniques)]
DIrEF—R—F (Keyboard )17 avhoBEEICRA IVIREERTEET,

Keyboard

"ﬁb‘ 50&1 una corda

1 FRICE HRATAURE I YRATX—IRE )L, 9FIUEREILOZER N
HY. INSEFEALTHLLRSLBEERTEET . RYULBREERT 2B ME
FEIRLTEET R0y 0T 50 HAWNE. AHLBIRETCHEEST R4
DED)yIL RATIZV)YITURRS YT LTRA ILREERL. TDRT LR
FERLTBELGTaAL—2a vER/ELET,

2 TEHOEBZFEALT. EFEOARFILRICH L, VTA4 0% EMLEZY  RE LD
BMIEEZY (FIFARAN U4, FIFARAN 12, FIFARAN 34, FIFARAN
1 OFELEMAD) THIENTEET, ALERSNTVGRNILZHERLTHS,
BET BRIV EI)YILT N TAVERIERTIILOESOELEEBMT SEE
DRFIIREI )V ILETS,

F—AR—FEFERALERAILEOER: ERLE-EFOEEAICEINT, (&,
ZATYT AR, [Shift]+[P] THRYTA—N\—ZRRLTRFTILIREERT H
EHTEET,
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BEDTIL—2a DR IVREERTBICIE. FTRSIILIEEZERT 55/
ZFEIRL ., RIZ [Shift]+[P] L. YR TR ILDHEIEIped]. VAT X
—kRFNLDFZEEEsost], DFALFRFT)ILDIGE(XTunacordalEABLFE
‘d_o

RTYT ANBEIZRE )AREERT BIZ1E RT IR O BRI EICF v LyrEE L
THhi[Shift]+[P] LT, BRATEHIRTILIRDEBREETEAALET, XRI<,
[Space] THFrLYbERIESE  RTILBEERLFET . AT ILBRER T THI56
(X, BE [Shift]+[P] #IL. Y RTAURFTIIRER T TIEHEE(EX+]. YRTX—
rREIWBER T TEBEEMs ], IFANERTILBERTITE5E5Fu* 12 A
ALFET,

Fr ATVYTANTREIAREA AT ERIZ UTAORT L DESDEILE B
MTEFET, FrLyrERRIELVLEISES. [Shift]+[P] ZHLT. UTAID
BRI, FIFARAN U4 OELEMASIEEXIVAL, FIFARAN 12 OFE
LEMZZBEIEN1/2], FIFABA 34 OELEMZDEEIE3/4]. FIFAR
~N 1 OFILEMASEEFILIZAALES,

ERLT=-RT VIR DB I B ERE T HITIE. RFILIREZERL. [Alt]+[<]/[—]
LT RI IR EREREZIERDELBICRFYTTEHH.
[Shift]+[Alt]+[«<]/[—] ZIL T, RFILIBORIHERTEXRDMAEIZRFvTL
E3 R

HEAT 3y REVBONBOMLBEZRET H-HOD—BDA TavETA
T. &4 T3> (Engraving Options)IICEHLGEMEN-TRF LR (Pedal
Lines)IR—JIZHYFET . COR—VITIE, FRERFIILBORBMBICRTT S
BB, FRMAERORBUECOERRBORTAE. UTAV/9FDEILIE. Wi
PEBEFALTEBHIERTILOBEIDEILERTTINESIHGE, SFEFE
BA T avhHbyET,

TONRT 4 REIVREZIRL. TONTA/3RIVIZHLGEMSN =T RS LR
(Pedal Lines)IZ IW—TTTANTAZRHETHL BARDORTJLEONEHN LES
SNET, T [EHTHFORMMN S (Starts before grace notes) 1B L UTE
tHhEHDEITERT (Ends before grace notes)I7A/ST4ZERALT. REILED
LR TEEMHE ORI EILERAICERET 2N EINEIBETEET,

BEE—RTIE. HRATAURTIWDE LT AU AR ITRIRTES=0, TR/NTo
ZERIERETEET, TANTADIRTILBD)TAY (Pedal Line Retakes)1%'
W—T T HRATAURGJLRITEMT BVTA ORIV DESDEL T EIRTEE
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T, ST UTAVRIDORT I DEEHAH DRSS T)TLODRTLARJL (End
level at retake)]) EUTAVEDREILDEHAHDFRE ()TAIDEBLAIL
(Start level at retake)]) FIETEET , TDOLARILEFHLOLLAILOBTRA )L
ERLITRT ENTELRNGEEIE. TVTA9847 (Retake type)1&T)T44
(Retake) I TIEHLILARJLEZERE (Change Level)IITEELET,

FETFTORTILIRDRE: FEET—RFTRIUVBERIRT DL, LLTD/N
VRILIRRTREN, T IT4DIITREETEIENTEFY,

O/ e i\ =]

REVBOBFIRMEET. —BEDNVRILEEFFEITFIVITHE REL
ROFIRMEBEZKTEARICBETETY  ERBOFMRMEDERICHD/\VF
W EFETITRSYIT5E FBRMEDRT LDBRSEERTEEY,
DTAVRETYTAV/9vFDERDNURIVE EFEITICNSVI 5L T4
JHIDARFT IV DESERETEET . VTAI/9FDEBDNIFIVE LFETFIC
F39 T3 2E NTAVRDAREIINDEESEEERETEETT . /VFDHRTIZHEH/\V
FILEEFBRITRSVTTHE VTAIEREKERRICHBTEES,

REVBOBR T B TIVIDEHEDNURILE LT TICRSYST5E T
IDRSHELEBETEFT . BRIDNURIVELFEEITICRSYI 5L REOR
BIIDBEELERTEET . IVIDTDONVRIVEEFEITRIZFSYT T 5L,
REJARDETHEEZKEARICHBETEET,

FIEMES LB EMEDTFRANDEMIE: 12EAE. DFLFRTILERO, &
EiXXFEE B TIFH< Ped. THRRALDFEAZERLTLDIBEE DY RTAURT LR
HE BB TRAKXF (THFAN) TEHEINTVARFTILBDOEZE. [TFRE
(Text) I TANRTAEREL T RELIBOBIBRMEICR RIN TS XF (TFXAH)
FEMTEFT, T TERTF XL (Continuation text) 17O/ T4&#HwEELT.
R DRI BICR RSN TS T I RN EMICTEES, VFALIRT)L
BOEEX. TBETXAL (Restorative text ) I7A/NTAEREL T, REILED
B THEICRRSN TSI Tre Corde] T X ANEEDICTEET,

BE: RAIVBIIEIMIZBESNTET , YRTAURAILBDIZEIL MIDI Ok
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A—5— 64 (Y AT1Y) &, YRTX—RFJLEEDIZEE MIDI avba—5—
66 (VATX—F) &, DFINFRFTILEDHZEE MIDI a>ka—5— 67 (VIk
RE)) #RELET, —ED VST 412 RbwILAVE (Pianoteq XU Garritan
CFX Concert Grand) Tl&, Y RTAURF )L DBAAHDFSERABTEET, &
MIZDOWTIE, &ETDOY =T ILESBL TS,

REWEEOHBERKICET AT avE . TBEATa> (Playback
Options)JIZFHLGEBMEN=TRALER (Pedal Lines)IR—IIZHYFET , BIAGL
BETORTILDOTIFIE AFILBOFRTDITAIDRE R THETORT )L
D)) —ADORSZAEGTEET , T, EFFLEMBTOMELVATNEASTHA
MEBEDHEAAHE)TAVEBETEINEINELIBETEET,

MusicXML DA RAH: SR TR JLERIL MusicXML 774 IL DI LERAIRAD
ZEMNTEET , MUsSiCXML [ZIEH R TFAURT I DHEEL R TE RS ILDFEHA
HDFEEOEILIXERTEEF A,

E—HE

Dorico &, THILAZA Ff=lF 1 FE, 2 FEMELFEEINS, YE—F
EAORHHELTVET . JE—MEND T DBERES K-SR T
WERAR, ROT YT F—FTHBT BFETT .

DE—MEIIDER: VE—MEZEERT I, 1 FiENEERT S/ EHER
RLFET GEEE—FOERIZH L REFRESE (Repeat Structures)1/3RIJLDT)
E—MEIL (Repeat Endings)lto>ar T, REAVES)YILT 1 BIFIMEER
LET . BIRLFDETZBILIIC. 1 FEMETAVIDERESNET . 1 FIEM
DI<CHEIT 2 BREMETAVMMERSINET, 1 BRENOKIKIEYGRE
BT OINFRMERSINTET (FEELEWNGEER), 2 BEIMICVE—NEEBMNT SIC
(F.2 HIENEERATH/NEEERLET [VE—HMEIl (Repeat Endings)lt
923V T . REVEI )Y ILTRIDFEIREEMLET BEFED 2 HFiENET AL
[FVE—MMEABALIREEIZRY  BBIZIHLT, REL T O/MEFRINMERShET,
2 FEIMDSHEIC 3 BIENEIT AVEMENET, VE—EEIMT S8,
ZOTOERERYRLET,

E—FRIBDER: MHARETIE. —EQOVE—MELIEZTNEHN 1 EERIN
F9, TDH. RIVE—MENMIERTINDEELZELT. BHRICIEL: 1 #HTOHK
FNRTEINFET .1 BRINERYIC 3 EERIT DL, JE—MEIIZEREE
ET55EE. TONRTARILOTJE—MME (Repeat Endings)1Z /L—T Dl
E—FEE (No. times played)17A/NTA T, BEDVE—FAHEFHRELET . B
EIBIE—MMERD T OHFILNFEL T3> (Engraving Options) IDE&REIZ
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HOTEBMICEHFINE T, IXTOVE—MEIICKLT. COTONTAZHRTE
THEILEFHYER A, Dorico TlE,. TANTADBREIZFEINHHEE (L. B
[CVE—MERZRIEIERR I AENDHENTEONEST FEALTLSRKEIE—H
FIlICERSNGEWNIE—REZEMLET), ChIZKY. JE—FRIEDEFH. JE—
MELDOFHERUMNZNULIZESISICEFMIZHABINET,

JE—MELDRTTFRALCDERE: HEDE—MEIMIZR RTINS TFRMEES
(2T BRENHDBEIEL, TONRTFRRIILOMN)E—HMEIR (Repeat Endings)1
IW—TDIARBLTHAR (Custom text) I7ANTAEHRELET .

BELA T THAY, TIALIDEE. BLUVIE—FRIBORTERAG TS
AT avid, &+ T3> (Engraving Options)lIZEFHLGEMESNI-TYE—F
& (Repeat Endings)IR—TIZHYET,

JE—MELDRTMEDZER: VE—MEIL. HERISEELTRIRISNDSTAT
LT . TLALAT7OrATFL 3> (Layout Options) DI &R EMER (Staves and
Systems) IR—CDIMERA TSIk (System Objects) I TERLI=A 2V Ak L
AU EIZRRENFET,

HEE—FTOUE—MELIORE: SLEE—FTIX. FEDVE—MMEIIZRIRL T,
EFEEEEITESYT T50. [Alt]+[«][—] ZERTRE. VE—MMEIZE/NIMND
INETICR ST CEET RUE—MENOBBLEFE IR THED/N\UFILERE
RU. EFIEEICFSYT LT VE—MEIEFER T /M PLIZYELLIZY
TEFEY,

HFEE—FTOYE—MEIORE: HFET—FTIE. BN\ RILEDLLT O
B9 5F=(ERSYI LT, HBLEME—HMMEI (Repeat Endings)17 IL—7®
TONT4E2FERALT. KFVE—MEIOMBHELR TREICH DT VI DKFESR
BEEREICHAZELRLY, BRICHTIRVE—MENOMLELTYIDRIEHREL
YUTEET,

MusicXML DA AHEEEZHL: JE—MEIIX. MusicXML 774 LA 5ERHAA
LIEMTEFET (FzFZL. MusicXML (&, —EDJE—MEROH THRIZEES
NTLBIE—MEILD . AL TWEWARIOUE —MEIZERELTOEREA). F
f=« MusicXML 7/ I)LEEEHITE. VJE—MEMLEFENLLIITHYELT,
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R T—FTORSR

RMEE—FTE. 7TATLOMEETAL—3aY (BRETHIEE) ERETEET,
T XVRZERTDE FYRBBISTATLEERTETT .

ROREFERALIER: RORZERTHE 1 BDOBEETTATLDORSEER/E
ETEFY ERLRI7TIRHABDREE T BET S/ IRILT (F952—TR%E
E) ERLI=-WTFATLED)VILT. EDTATLEERT H8EREY)VIL. I
ARAVERLEN ST AT LERSYI L TRELGTAL—2avER/ELFET,

IDREFRALIRSE: TaLb—3ay (RS— ATEV REIER. F05—T#H.
JIVIEE) DR ESINI=TATLEERT S, TORBHNELKE TREICHR />
FILBRRSINET . BIR/N\VFILERSYI LT TATLDRBEEEZRFTYILE
T CNEE RTRHBIIEDYERA (FATLDTAL—avEERF-(XENE
TEED) BT NURILERSYI LT FATLOERTREEZERTYILET . CDE
E RBMEBIFREDYFERA, RSEEEET I, 7TATLEFHLWMIEICR YT
BIZIE. NURLTIEGL, TATLEREERSVILET,

aRUREFERLIERESE: F—hR—KFa—rhyk ([Alt]+<)/[~]) ZFERALT. &R
L7 AT LERTEIERDEBIZRFYTTEET, TaLb—avhkESATY
BT7ATLDIEE . F—R—FIa—rhvk ([Shift]+[Alt]+[«<]/[—]) ZERALTT2
L—av s ERFLIIERTEET . ROBEMNME TIEE BEDVX LT )Y
FTFal—iarvTRFyILEzYVERERLIZYT B5E(E. [Ctrl] 162 THEALE
ED

MBS DRE: YVIREFEALT. Y IIL—TIbESh -8B SEHmETEET . A
TEVTRFESE IR HET IIL—TDHEE . ®MIET HIGEFAICAR N\ FILNRRS
NET ZONURILERSYTTBE T IL—TE#HLIMIBICBETEET . ATE
DAY T A —FIDHE I BB OEENEDLLIRAUMIELES >
FILAR RSN, CONURLEFERALTERREHLWMIBICR YT TEET . J
=T DRDEIERRICHIBBIEETENSVI THE MDRBIESDELED
TIN—TL£EORIICHHILTRABINET, . BRENRBEREOTIL—TD
PRIZHLFHERBELE T IIHEERRBILEEEFIVI LT HILWMLIEICES
TEET, AAORBERE (. BBNISEYICEREFERINET,

IYRIZEBTATLDVER: TBIBERTE (Preferences)IDILfE (General) <
—CONESE (Editing) 1V V—TI2HLGEBMESN AT aVEFERT L. F—
R—F TV REFEAL T, KYRBICANCREEITHEZAET [TIRIZK
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BERTATLDOEREZHTTT S (Allow multiple items to be created with the
mouse)|ZRET D&, BEE—RDED/ RIS TEERD T AT LEERTE
F9.BATATLEERLEETREEHYECA, T [RVRICKDITITL
DYERX (Creating items with the mouse) I Tl&. IBFERIRFP O ALEIZ Dorico
DTATLEEEMICERT 50 (DHEE). BIZTVUYITTATLERETES
LT EMNEBIRTEEY,

ESER: TATLIERESNSMBLHEICT 570 BIRLI=T A T LD KR

B (R5—, AFEU. AVE—T. RELEHREDT L —2av B EESN T

BTATLDEEE. GANLDBELHD) EROEZMBONRAETHIE
D EBEHNEIHNNES ., [Ea— (View)) » NEFHR (Attachment Lines) I DER
R ETTE COF T EEHICTEES,

BRDAR—L VT DORE

HFEET—FT.EBEDETRPIALDAR=V V) E#RETEEFT , AR50
RAREZEDCT BT, BFET—FROERDRIICHEEHFDRAR—IT
(Note Spacing)lt9>a>DAAYFEFAUNLET ARV VT REDETAT
LIZHLTAR—=O UG ASLETRTHIRENRILBRTEINET , AT LENDR
ILINRRENZE REDLAT I TCTATLOEROCIRENTELGLRYFET &
BEDERBIVHBELITHIBHEE. TEHFDAR— Y (Note Spacing) 1ty
AVDAAYFEFTICT B, BEBE—FICUIYEBZET,

J_l& ..................... A tempo -
e e e e ™ e -t

+— t = LS FE ; ]

82.2/88.6
1

| ] 1 - - _‘- { H ]

AR=VVGRBETFT74NIVRE: EREMNE . EHEF. AT, SHES. 7
B BFES. /DMEHRGEEDKEMEFRESTSHEE 2 2HYFET, 1 DIEFAR
—S U RBTT . FATLDEED) ALAR—RELLLEY LY TEET,
CORBIERAR=I VT ATLEEK (TRTOHERICHIz>T, IS LAIZEALIE
EEOTRTDTATL) ITERELET .15 1 2T ST714NIILAETT ERL
F7ATALIIE—DERETOHABELEST . MDTATLDAR—L VT (2R
BLFEEA A=V VT RBETEIGE X EARN\URILEREIRL. [Alt] ZH#
LEDS [«][—] F—%FALT. LT ORBLET , KEEAE T HIHEIL.
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[Ctrl] (Windows) F7-=IE [command] (Mac) Z#HETHEALET . ¥V S574HILER
BETEIGEE. REROLIZHAIEAR/N\IFILEZRL, RIZE 3 BRE
[ZRRESNTOBSEBNVRILEZRLTHS, BLF—FR—Fa—rhyrEERL
THELET  [Tab] ZFTE. EARNUEILEARNCEIILORIREZYYEZ S
EMTEET,

TIA)—BIZH L TRAR—I VT AR ETESE EABNAURILERR—
AT LETRITEBLAFRBE TR RINET,

FTATLIZHLTT S74DIVRBETHSE. TATLOAMNRILETDEE
(RAR—=L VT DR SNTNSAE) ZOHCHEBRAFRETRRINET,

THhoF)—FEATLOFEE: RLMETHEBOERNENLGEE. RFEHISL
DR EZEAICHETEET KEFBASLICEARNRILARRTEINET , &Y
DIAZLEFRNZAERDAZLDEFICHLTAR—D T RBET T4 DILERE
FTHSICENTEEF T MOFREFHASLEFEFL TN IEREARITILEN
HHGEIE. TEEBASLIVTYIAR (Voice column index)1 7R/ T4Z&FEHALT.
HEDFEEEEFDFEIIATLICEEITEET  CNITKY, DOITLEFRIZ, X
R=UVGRBET ST NIWRABRETESIENTEET,

NURIIVEIDRE: KENX—%FEALT. N\URILEIZBEITEET, [Shift] L
BNSITESE EHDN\VRIILVERIRTEET , [Tab] 2T E AR—V VTR
FADEABNEILETST4HILABADOHER NV EILOEIREVEZ HEMN
TEET,

—EIEBDTATLERAR: SELEREIE [Shift]+[«<]/[—] F—FFERAL
THEHEDONRIVERIRLET , F—R—Fa—rhyb2FERALT, EIRLE-T
RTDNVEIIZHLTRAR=D VG RBET ST DIV BERBFIZITHVNE

ERR

DR B—DAR— VT RBELIETST4HIVAEERERT HICIE, 7\
RKILZEIRL T, [Delete] ZHLET , AR—V VT ABRET ST HILABRDOE AN
BRASNTWSTATLDESIE. MADRABNERINET . T IT1HILAED
HERBRT DIEE L. BEE—FTTATLEERL. THRE (Edit)] » RS ay
#1)tvbk (Reset Position)1Z#R#IRLET , KYLELVEEICH->TAR—L VTR
BERRIDIGEEF ABEZHBBRLEVEERD 1 DFERLEFEHDO/NVRILEZERL.
%% (Engrave)] » TIEHFDAR—L S (Note Spacing)l » TLLF7orE+
whk (Reset Layout) IGREDL AT IS TRTDAR—=L UG R MNEIRESNE
7). [BIRLI-OL—L%EtEYE (Reset Selected Frames) (1 DFE=IXEED /N
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URILHRIBIRSNTOSEIL—LRAD T RTOAR—I VY BRI EERSH
F9). FEIMBRU-EEREU Y (Reset Selected Systems) (1 DF=II4E
HONRILHBREERENTODEERND T A TORAR—I VT REBIEIREN
FY) ZFRLFET,

HEBZEOYY: PATLIZAR—=S DT RBEIT ST74 NIV RABETET-15

B, AEEZEALBEREIOYIENET, Dorico 1%, SN D RMLAAL

B (ERSNTLVEWNES) EROMBEEOBIRAEICHEBERUIYEERLET,
INITKY . AR U TRBENITEONTE LAT7IMDERERETEEIN

FE A

HBEOEFERERTAOT—8— EROAR—V T EHRETHEE. GRAIDR
—ORBIZHLNAV DT —8—DBRERSNFET, ThIZKY ERIEICEFNED
BLEFI>TWONE— B THRTEEY . /\—toT U TRTRSN., FARTREL
AR—ADEHHEDHFDEEEINTVNELIRAR—ADEIENRTEINET (RYVIDE
HESHEIVFASDEADFIRMEN SRED/MIIRETEZETRILEY), RN
TRITEEITUOELGER AV D 73— [FEBTRTENFET . 70% #BEF-T
WAHISETHRBETRTINES , LRZHEA TS (100% #8) HEF. FBETRT
ShEJ,

HEDATUN BHEDIREIRIZ. 2 DOREGEAH/NAVRILARIRISNE

T NUFILDOERIE—FBLDERDE 1 RITH>TRRSN, BRIE—FTD
ERODE 5 RITHE>TRTRSNET LD /NUFILERLCF—R—FLa—rhyb
TINLDNURIVEFERTHE TLU— LD HBEA O TUNTEE T, RO
AR—V T EmETDERERERLGY . (VT UM TR THHRIIOY SN
W=o,  BEEREEZEET S ENTEFET,

TO/RT4: TANRTANRRIVEFERTEE FEET—FT.ERAY—ILUNDTAT
LIZHL AR—=V VT RABB LIV ST NIV RABEIRETEET, (FEALEDE
FLUANDTATLDEBE. 7TATLDTONTATIN—TIZHBAR—=S 5 DT
vk (Spacing offset) IZ#E AL TRAR—L U5 %L [—#% (Common)]J
IW—T12HBIFT7Eyr X (Offset X) 1T ONT«EFERALTY ST DIV RAEE T
STENTEFET, BERDHE. [FHIATLDAR—L T DF 7€YL (Voice
column spacing offset) I 7O/ \T4ZERAL TRAR—L U %,

E#HaS5L X A2+vbk (Voice column X offset) 17O/ T4Z&ERALTY 504
HIVRABETESICENTEET , oD TANTaIEmA LD, FHLGEMESN T
[EHDAR—UY (Note Spacing) 17 IL—FIZHYET,

INARFDOREZRE: tOARFOEFEFELGY  DMEIRFIZIEANAURILAE
RENFRA, 2L, TRNRTANRILDOT—f& (Common)1T IL—T D47+
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h X (Offset X)IF O/ SFA &Y B INGIBET BN IKB DK TAIEE
AETEET,

24IL53—

BIROANA—EFERTHEBELEEFHICEDINT, TSI ERLE
DMDT AT LOBERERD_ENTEET . [#Rsk (Edit)] » D1)L5—

(Filten) I T A= a—AFLMDHY , SESELGEED T AT LEZRBRE L VER
FERR T BT L A—HEREABINENE LT, TILA—ZFEAT BT FTHEHD
TATLERIRLET FEAE NEHDZEBERZED ) VILTNERD T RTD
BERBLVZTOMDT AT LZZIRL, RIZ [Shift] ZHHLEANSRICEERFE (T
DERICHIELGDHNEZEV )VILTREREERLET . TDHE TIILE—%E
RUT ERICIWAF=WT AT LERRNOEBRLEWT AT LZEZRELET T

[¥R&E (Edit)] » TO4)L8— (Filten) YT A=2—D EEIZHDHRIRDHA (Select
Oonly)1E=IXNBIRBER DA (Deselect Only) IONT I AEIRENEMZE-T,

BIRUIZTATLOHEERICET OO GBIRLIZT A TLEERISERT HHH
REVET

FERATELTAIILE—([FLUTDEYTY,

o FFHLMFT (Notes and Chords): EHfF. ZEfiZEF. BLUVEFEEIRT (L&
REBBRLET

o KT (Grace Notes): EMiBFH DAL ERFILERMBBRLES,

o KT (Rests): BATREIZIRET. BIRRIA/DETAR . BRUFITRUVMATFEEIRE
f=IXBIRNFRBRLE T,

e FHE (Voices) HJ4AZa—: [T RTOFERMNLAZTOEE (All Up-Stem

Voices)l, [T RTOHENTHEDEER (All Down-stem Voices)l. Ff=I&,

BROMEVE—DEROADZE . TOERTESH TSN TLLSFEHD
BRICBIT DT R TDTATLEERFILERBERLETS,

o FTRTMDKFBEES (All Dynamics): BERIETEIEE (EEX®BRIRSLA
FlEED) BIUEEMERERES (NTEV Ay T J+—Fz, Iy
IVRFERETAIXIVREED) #BIRF-IEBRBIRLET,

o BEMATEEEE (Immediate Dynamics): BERHIATE LB DA EEIRE (T
EIRMERLET,

o ERRERYTATEEE S (Gradual Dynamics): EXREROTRSSEE B DA BIRE - ILE
REEBRLET .

FTRTOTVR (All Tempos): BETUR., TR, BLVERBEHLT R
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FTARTEEREILBIRBBRLET

e [ERETVHR (Immediate Tempos): BETUR (FUAUTEE) DAHEERE
F= T BIRBRBRLE T,

e HxTUR (Relative Tempos): #xITUR (TURLGE) DHEERFEILE
REERLESS

o EREEMLTUR (Gradual Tempos): BRRERIGT VR (YRILEURI7YFILS
URGRE) DAHEBRIRFILERERLES,

o TFTIRIUFEHE (Arpeggio Signs)

e 1—FE%H (Chord Symbols)

o HHEIECS (Clefs)

e J1yHR (Glissando Lines)

o RRFEELKILESE (Holds and Pauses)

e HAE (Key Signatures)

o A& (Lyrics)

e F445—T# (Octave Lines)

o EMFELNJIL (Ornaments and Trills)

o RALER (Pedal Lines)

e BEH(E (Playing Techniques)

e Un—H)LT—% (Rehearsal Marks)

e RAJ— (Slurs)

o FHZF (Text): [Shift]+[X] THERR Rk

e JFEHS (Time Signatures)

o EFF (Tuplets): EFDAFBINES (ZOHDBEFTIELGL) ZBIREILE

REEBRLETS,

o FTRTOHEYY (All Breaks): JL—LRYIYEEHMR Y FRIRNET- (L RINAER
BRLET,

e JL—LRYIY (Frame Breaks): 7L—LRYIYDAHEFEINE - (LRIRAERRL
79,

o ERXEIY (System Breaks): ERfRXEIY DA EEIRFE-ILERERLET,

BEE—F
BRIN-TaAL—2avBiURESNzTaL—av DOmEFH LR
AUNBEE—FROY—ILRYIRIZEMEIN (BEZSR).2 DOE—F% I
PUBZONBLSIZHYELz, CORIVEFALT,. BAEE—FDAAR
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URFARTLAT, BESN T 1L —Sa ERlEh =T al—oavE
FETEET,

BEINI-TaAL—2avE &R ERESIN-TaL—2aVFE7/AB—IL TR
TLATEFORKELTRRENET, CIITK,. BEFICERAISNATOAEATIILY
b (RAYA—bT7—T4F2L—2a3 a2 FALTEZRTSH. A—%#FALTEZER
KT B74E) NIRTEFATWET . —A. BESNTaL—2aviF EEFAN
RO TICHWLMETRRINE T, LS izTaL—2a % RIRT 5L COBREM
HIZRY, BN T 2L —2ar A ERFOARKEL TR RSN, BEESNIzTaL—
DIAVEBEFARNUEOTIZHOME TR IISNET,

ERINTaAL—2av ORE: ARVMTARTILSTEHORBHB Tl —
DAVERETDHEARVNTARTLAIE (RVREBRLIZEZEFTTHL) YT LA
ALTEHFEIN, FEABLRBRENET . EROBETaL—avhiREShdE,
FOEHIEL. E7/O—ILTARATLATREVNVETRRINETS,

BRIN=Tab—2avITMAREEZHERLT, TIHLMDRBHES SV
RSICRTIGEIE. REITHEFEERLT.BE (Play)l » TBEDELEY)
tvk (Reset Playback Overrides)|Z:&RLET,

RESNTal—2avDRE: Sl -Tal—2a zRETIERE.F
FEERLERICFSVITHE LFYBWFERRFKYEBWNIASVTICEREZREHT
ETFEY, ERFREDQVXLYTVIMEIZRBRENTVWASMEICR TV TENET,

BRELTICSFSYI 5L EVFEERTEEY (FEE—FTRETIDERERIC.
[AIJ+[ T/ L] Ff=1& [Ctrl]+[AI]+][ T[] BERTEEY),

F-. BFEERL. BRLE-BFOEWMERSYI LT BEFDTL—L3aVEER
FTHIELTEFT, FUBWERIFKYBL RSV IS/ EBREL-BES. 5D
TaL—2avFBREDY X LYY YREIZISCTRAFTYTENET,

RRIC.ARNVMTARTLATERENYNT URR—RFTEET, AYPLE-EF L,
BEANYFOMEICBEYMITONET,

ARV TARTUAIZRREINDEE: BAVARYIILAVIDEEIZT AT, B
—DhSYIIZRTINET,

IL—5— BEE—FT ARUVINTARTLADERIZRTSNBIL—F—IZ.
BN FIESO/NEHEHAORYYERHLTLET,
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29—  X—L,. FEF—k BEE—KODARNITARATLADI—H—
IHARNYIVZAMNKIGIZSRESNZELT =,

1 EDwEEYIVFIZ, MDE—RICOYEZ, ZOHEBEE—FIZEST
HARNVNTARTLADI Y DRAKEAMHIFSNDLSICHYFEL: (B
HEDLETAH Tz RELTEERWVEE. BERKREEEEIhEEA
N SEAETEIFETY),

o TIFAYFIIVIINYREFERALTLSIES. 2 KIEEOVIRFYTIRUL
TARATLADRYIA—=LE LIV R —LNTEDLSITHYELT=,

o ARUNTARTLATIE, KEARDRYO—)LEX—LMWFHIBEINET, Zhic
&Y. 7O0—DRBREEF IR THEFEFTLARYA—/)LTET, £, BIETD
MB&YBNSK(RX—=LTINTEHILETEFEFE A,

o ARUNTARTLATISYIERRALIZEEIZ. EDAURMYILAVTEESN

EFOHEEOPRICE7/O—ILE2a—NRFRSNBESITHYELT=,

o ARUNTARTLADERIZMIZRTRSINTOBET /F—HR—RIZTTIX
RAVA—%F . [Shift] ZLENSIVRRA—ILEEHNT L ET /O
—LEMEIZRIB—I)LTEET,

o ARUINTARTLATERORIGEIEIEREED) VIS HEEICHTHLELME

DERBINFEL, TOHER. V)vITH5TEITE T, KYUBBEIZERFEERTE

BEIITHYEL Iz, T, YO RRAVA—DEHFINELz, EFO—EBIZT™

ARAVE—%ERDHE. TTEV)VILIZGEDBENRIIINET,

BEEREDORT AVAMIIWAVMIERTS VST TI/RTLyiarvvTIziy,
SESFLEF—RAMYFB LUV T7—TaoFaL—arhiBfiesnEzd, Tho&ESER
i£% Dorico REDKSITRYEL T LTWSHEREILTBIZIE. BEE—FTIY
ARYIWAVRDI SV IEREALET . T5&. FHILGEMENFRL —UARRSN.,
WED VST TIRTLyiavIvIDRBRAYFICE > TERSN DB EHER
TEFET . F. L=V DMEEICYRIRRAUE—FERDHE EVIRRESN., FE
TIERMNREBEINETS,

MIDI B AT/ SA RADYHR—F

EiSn TS MIDI HATNARABHTEETELLIITHYELT, TMIDI A4
VARYILAVE (MIDI Instruments) 1293 av s, BAEE—RFOARID /SR ILIC
#FLGEMEH ., MIDI TNAREEBIMTESLIICAHEYELT, MIDI T/ALRIE,

LWL VST AV RRYILAVRERICESISEBINTEE S MIDI T/AREEMT
L. BEE—FRTAIRUVTARTLADERIZH B I~NT —EFRALTH

EEREL. TOCTILDAVARYILAV DB EE MIDI T/31 ABHTITES
FOITRETEET,
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MIDI REVDZXH—DY—)LN—IZFHLGEMENFELZ, CORFEFERALT,
BAVRRYILAVED MIDI 7z—F—%RRTEET . & MIDI Iz—%—(F
MIDI avkB—5— 7 ((RYa—L) ZFEEL. T—F—D LDV RF4F—[&
MIDI avkA—5— 10 (/) ZEELET . MIDI Zz—F—DVOFE=(FIa—
RMZIERIELTOER A

00—

BFEO7A—ZRE: LA BREQKRBZAOTA—LLTHIFLEA S, 5L
HEETHIEE. REE—FDOITO0— (Flows) /AL T7O0—%&RL, a>TF
AbAza—hnIo0—%#E8 (Duplicate Flow)1Z:&IRT5E. 7O oD
O—%aE—T&% 9,

BEOI7O—%Z22E): 7ERNROIO—T, DETHIRAUMNHLIEFEEED
BEFEOIO—% 2 DIZHEITEET,

A@ Dorico 7Oz IMLI7A—ZHmHAE: TopA)L (File)l » TSHAAH
(Import)] » 70— (Flows)1Z#EiRd HL. FID Dorico 7ADIIMME 1 DF
EIEEHDIO—EHEA AL ENTEET . A RARROIO—DNEEN TS,
FAIRAAITTD Dorico TAD IV ERIRT HSBENRTINET  FAT7OTHERT
SN RARAATTOD I SHRAAARMEDTO—ERIRLET , IHIT, AR
HETADIIRT, ZHAHARMEDIO—DEEEEDLSITTL—Y—IZEY LT
SMERRTEET,

o FTRTHFRODIL—VY—%ER (Create All New Players): HiAAHTS
02O 7a—CEYETOEN TS T L—Y—[E T RT, FHAAETO
DI THRADTL—V—ELTHERENET . BREITHELT, TL—v—IC
g B/IN—rL AT IREFLAERENET

o THRIBEMFEDNTL—Vv—LT— (Merge with Existing Players Where
Possible): HARAARNRDIOA—DEEEBRFDOTL—V—ITEIY B TESE
LET . RARAAREODIA—DTL—N—,RCA VRISV AV REFAY
AR AD LY ERFOBBFEOTL—V—AMERENET,

MusicXML 774 )LvbT7A—%5AAL: Dorico AV TIRERWLT, 74
(File)1> &A% (mport)] » TMusicXMLIZERY B, FHT4TBTADTY
FOFHHRIO—EL T, MusicXML 77AIL NS REFRAADEMNTEET , F1iR
TR IrELT MusicXML 70 IVERERWEE L. TT7M4IL (File)) » TA—
7> (Open)I%ERLT MusicXML T7 A LERIEES, B0 Dorico FATk

29 R—3 Steinberg Media Technologies GmbH



G steinberg

Mo 1 DERIFEHOIO—EHAADIGE ., SHAHIRAHITD MusicXML Z74)L
#BIRTBEFAT7ATNRTEIN, RARAAETOADIIRT, SRARAHATGRD T
FAILDEEEEDESIZTL—V—IZE|Y B THEINZRIRTEET,
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EREFRCH
[EEEFEC S X AT+tvbk (Accidental X offset) 17O/ S T4A, FEE—RFDOTO/NRT
AINFRIVIZRTENDTBFEARFT (Notes and Rests) 17 IL—TF (BN, Bl
BOKFEABEZLZE R IHAETEDLSITHYEL,

FILRCHREE
BE: T7ILRCHEEE (Arpeggio Signs)IZIL—TN [BEFTLayv
(Playback Options)IDT44324 (Timing)IR—U(3BMEN., PILRTSHES
FHRETEDSIICTHYFELZ, CETIE. ZIRDADE—FTOREFEFF L.
TIRSF DRSS, BLUT IR ORI ERT NS CRESN=TaL—
DIVDBRREIEERETEET, T [FILRIABELE (Arpeggios Playback)]
TI—TRTANRTAARIVITBMEN, TILARDFRBIEIT IAIVOBES
ToavE L EETELLSITHEYELS:,

FEET—F TIRCARESEMFICHLTHEEIEEICBETEDLSITHYEL
f=o [Alt]+[<]/[=] TLLT2BHSEY, YIORATRSYI LY, $EE—FD
X #78vk (X offset) 17O/ ST THREILIZYVTHIENTEET,

INER R

&4 723> (Engraving Options)1DI/M©Ei#E (Barlines)|IR—2IZA T3y
M 2 DEMEINEL,

o [A2VRRHIILAVFRAD—BREBO/NTHRDOEKE (Barline length for
single-line instruments)1 Tl&. L FTOEREBEELGEVELSIC EROLT
[ZAMED DAR—REZEITENEIRETEET,

o [REFBMRRIZEIIBEDEERDKRIHD /N (Barline at end of
system coinciding with start repeat) I TlX, XO/NETDBIRGLE 2 18 B
IRD/INEIRD H D HZEIC, HEORIGO/DETREEMHIREEMBDOELLT
RRTANTEIRTEEY,

EHT
BT IL—TDNE. THRE (Edit)] » [5EH (Beaming)l » IEH#EHE
(Split Beam)Jaw o rhEMEN , BIRLE-ERDLLE CHREDEN T IIL—T%
BRDTIL—TIZREITEDLSIRYELIz, A2 —DSEBOEMEL LMD
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LT B0, BINN—2ar ONERTZET T (Break Beam) I\ EHTZfE R
(Make Unbeamed)JIZEfrshE LT,

EHEEML OV —TICT 5@ L FICEME T KTEIZTIIGEEEEETD
AT avm, B4 T3> (Engraving Options) IDOTEHT (Beams)1R—S D
M&E# (Slants)1¥ IL—TF IR TSNS EEMEE (Advanced Options)1t93

VIZEmEhEL =,

3 DULDELIEYFEE DEMEIAVT—TERGITNERET DIHE (EHY
=T OHEOEFHIEIHRD T &Y LEHITAVGE) (2 EHTICHRBIEVRE
DEFHIPEIRICHEIEFEYLEEIEMITEVGRIZOVr—T ERGT M, EMH
[CRLAEVARIOEFEMFEDOEROEBRLEDMENRCHEETHLAVT—T LR
HEMEHRETEETT, PR ETIIRIN—2av R RY . EHY IL—T Dilis
DBEFEEHOABDOEFOEBRLEDAENRCIGE (TEHTTKFIZHYET, B
N—=2aV ERILEREICRT IS TRAIOFFS/NAIOFTFERCEEICHSHHE
(Inner note at same position as outer note)1&Mavr—J LI RiEEELy (Do

—Zna

not treat as concave)JIZERELET,

MR ETIE., EHTYIIL—TEaVr—TIZTBIZE., EFICRHEVAEO B HA
EHOWIHICH T HFRYLERISERITNIENTER A DOFY. SMADE S D
BERLYLEH DAL (FIEERLORLLE) (CHIBELHYET, REIOE
BFOANADZFHFDORADHLYLEHISENEESEHT Y L—TEa0y—DI129 5
CIE. TREIOFFLANBIOETFO R A LYVERISGEVEEICH DI, £5—H LY
HLEHT M SZELMES (Inner note closer to the beam than one but not both
outer notes) &IV —J LR (Treat as concave)JIZERELET,

BFROENE: %EATL 3> (Engraving Options) IOTERH (Notes) IR—2IZH
HIER (Stems) 1T IL—TDIFEDEHE (Stem Shortening) 1D FIZEBMET-
AT VT ERODEDME CTHEDEBEREFIIFLTINERETEDLL
SITHEYFELZ, ChiIZKY EFRELGE . BEROFENERONMIZRIGE. B/
DN A DFER P RAR—R (I IKEFRERNERINET .

[The Art and Practice of Music Engraving]®# T, 7Yk -OXKILEH{FE 8 &
EFOFEDESE . KFOEHDIGEIZRAR—ZD 4 50 1 ABRILIEHTD
BEIFAR—ZADERITERBTREERRTNET , TIHILEDEHFE 8 BF
FOFEORIIIEMOHEVNETFICLERTEES1-86. Dorico 1.1.10 TIX#EAK
ECHEDEMBETEOEVERELLGYEL -z, LAEIOEMEICRLIZWMESIL. [E
HITW—TDOFBDOIESRE (Stem shortening for beamed groups) 1zl &E#rah -
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FFR%ZMEHME (Shorten beamed stems)JIZEREL TS,

REIC.4 PERETNULORVWER.8 B, 16 HBFETNULDEL

BRGE. REDEBIBERILIIFREDR/MEERE TEDLIITHYELz, BF
LLWVEEDRSIOR/ME. ERADCLEBIZEHE-HEDER. RELTERIZTS
F=ODEHRDRAT VT (RO LICRET HMREECHAEILIRLTIFD) HED
HMEERITERICHYES,

KiEW (TS7vh) g (TLMR)

Mgl S IL—T DR 1 DEFRTFRINSBHESE (When only one staff of
braced group is shown) 147 av b, IEEA T3> (Engraving Options)1dD
[KIEM (FS57vb) &gl (FLAR) (Brackets and Braces)JR—PIZRRS
BT TFHALY (Design)ly IL—TFIBMENFELT =, THIFII%EHE (Draw brace)l
[CHRETHEET/RERERDESED 1 DOEROAEHRICKRTTIEE.
pEIlE ZOERICHI->THEINET, [FHENEZHEELZL (Do not draw
brace)JIZSRET L. KERDERD 2 DOERNERIZRTINDIBEDHH
BN EEINET,

BCE B E

MBEERE (Casting Off) £ av M. TLLFIrAE T3> (Layout Options)l
DIz EMER (Staves and Systems) IR—VIZEBMENELIz, ZDOEII 3V
Tk BEORTARICEETIHRENMTEAET, [BRERTE (Casting Off)]
93 TIE, EQMEIEVKDMRICRRL, ER—DITHEBEZLVKOERTT S
DERETEFET, COEIIaVITEMEINI=ATLIVIEUTOEYTY,

o HEH-YD/IMEHHZERERE (Fixed number of bars per system): #HEXDIFE
[CEHLT HELDONEHOHEEELET . RKFCEBEBFEEALERTS
INEIE 1 IDERELTRADNE T . BEBATFO/NEAEERTIYORTRIZH
XN BGEIE HERUYDZTNZTNOHAA 1 PMEIELTHALNET,
EEDOEEOH T, MBEO/NHHZEAELEANEFELVEDIEHYFE AN,
FERIE, BT 4 NEHICEAETHERANTE, ZXUTyavnIL—
F—hUER., Fa—. TOMDERZEZTADH DO, Ly avDFEEIER
Y HEETEHIUNHREEELET

o JL—ALH-YDEEBHEREE (Fixed number of systems per frame): &%
HOL—LDHEOBEZEELEY . BE . ZHIL—LEIN—C0ESE2AFE
EHB=H. CDFTLaTER—CDHMEOHMNRFEYET, IL—LHTIZY
DHEDHIEZLDIZE/N—FZEICAESN .1 R—UHTY 10 ~ 11 BT
HEZEN—HETT,
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o IJL—LDEIIZAHETHEROMEIERETS (Scale number of systems
by frame height): JL—LNDOMEEHZEEL-HE(Z, BT EOL
—LDBIIZHBILTRHAS T IENTEET, ERIERR—VIZKRTT S
#E 10 BRICERELIZEEICE, /S—bD 1 R=DBIZAAML, {EHEE . 1>
ARYIAVREIEEDERDHAHEEEICFIATELSEINUBREDOAR—DICLH
RTPLBYET , COEIBBEICTDF TV EFATHERVIDIL—LA
28 ~ 9 BEDMEMNFRESNSG-OEFTT,

FEEOTHBRREIVICEIF—T /NI DS EIZEFTT (Allow open bars to
be split across system breaks) 1ML L7 bxFS 3> (Layout Options)1®
[FERFDAR—L2Y (Note Spacing)IR—U i ERERSE (Casting Off)J 4
avIBEEnEL-,

=

INRAAYDERBTINAAF) VBT ERDE 5 RLEICEESNSINERS.E 5
#1F G4 ZRHLET . Middle C DED G1E) M, BB EAI2—THR
(Clefs and Octave Lines)I/ARIILDIZD D EFEES (Uncommon Clefs) ]t
DiaviiEmEnELl-,

EHWREOEAMT: TONRTANRILOT—# (Common) 1T IL—TZHBH5—
(Colon)17B/\T4T. BB DERZRBTRT IENTESLIITHYFELT =,

aAE—7 2 RR—X |k

[¥REE (Edit)]> TEERICBEYAT (Paste Into Voice) [ YT A= a—hSBNEhEL
fzo THITEY . HAFIICE T IBEHOCTOMDT AT LE. YT EDERICH
SHREOREL REYFT-ERIE BEOFBNMFOERICV—UINET) LU H
BOLERAEFLETREZHEOEICHYMFEIIENTEET,

Lz EEER

MBS EERLI-EEIC, BT ARBESNEBMICT L—TLEhEzT . JIL
—TEENF-BBRBFEROLEF I TORLEEMEICEISH, EHOZD
MDERNSIEAEDT AT LEDERERET 5=, T IAILEDEILKES
HAGEBICFFEEOTRHTEEY,

BRI DEFTFEREOT I —TIELI-RBEEEFMDERAREYFTEE, ERD
BB TRIBIEEMNIVILET . DFY . HIERDERPICEEHRET D,
ZTRERE)ILTNAMMDIER EDRBES DAV REIV AN BENICER
ShET,
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BB BEIIN—TILTDARLERMTIVITEAEERETESLLIITHY
FLI1-, 85BRESE 1 DU EERL. T#EE (Edit)] » M3&585ES (Dynamics)]
YIAZa—oBULBTATLEFERLET  PATLIEIVTHFAM=Z2—H
HHLBIRTEFET,

o HABWEEE DS IL—TIE (Group Dynamics): EIRLI-AFBEIEEEZTIL—T
ELET, BIRLIBABREMNERIZT L—TIENTWRIGEE . VL —T& 4
BLTRYKRELGT IL—TEERLET,

o ABEEDSII—T{LEME (Ungroup Dynamics): EiRL1-4BEEENY
IW—TEBRLES T IL—T IR 2ITHIBRESNET,

o JI—ThoHIE (Remove From Group): #IRLI-EBREEDHES L
—ThBHIBRLET . ZDMDEHEREXERINELT A,

® U ¥ (Link): AN HS (RCLEIZHY. AILHRBILEETHD) HE.
BIRL-EBTESEEROERLETIDILET (FzExEp & T 1YY
DTEFEA,)

o ULOEMER (Unlink): ZIRLI-EBREST DI IVZMIRL. thDERDATET
FEVILIEWESICLEYT . BIRLIAB RSN T IL—TO—HTHLEE. U
=T D)y DERMNSEIRIN ., BB S EEACHEETELEIITEY
EX R

EDBBIESNT IL—TILIINENTNENERT -0, BBLESERIRT S
ECBRL-BHESEREORRE (FLUY) TRERSN, BALTL—T 0o
RIS P OERDABILS L VLTINS RB RS IIFTRRSNET,

AEEF

FEET—FDMOERBEY—ILED—ENERDH. IL—LOIRERIZER
IL—LADTATLILERTEELHEYFEL =,

FEET-FOERBEY— I THEERBRMEZSEIHYEL, ThIZKY, 8
HOIL— L0, ERCEFOMREREY S5/ \ VRV EBRISEIRTEEY,

FEE-RTIL—LERET HESIT, REIF—TIL—LDN\VFILEZHEE)
TEDRIITHYFLI= [Tab] ZHT & TL—LE2KEEIRT 5D (BRI DL
BARWVMETREREINEY). BRI DONUFILERIRY D (BIRTEHEEYDS
LTRRENET) OUYBEZIATEET,
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P&

Dorico Z4>A+— LT %E. Noto Sans JP 742 hI73)—LREBEHZAV AL
SNBESHYELIz, CDTAUMIBARZER Dorico TERTHEHE IO I
DT IAHIVLDITAURELTHERASINET , (

[FIAIEDTFARNR I+ I75)— (Default Text Font Family) 147 3> A
TBRIEERE (Preferences) DI £f (General)JIR—IITEBMENFEL-, BRED
FEAEEFE TIE Noto Sans P [ZERESNFT A ENLUND TR TOEETIE
Academico [CRESNFET . DX TLavELERTHE. [FIHILMDTFXFRANED
4>k (Default Text Font) D74 kAL ILOTFIAHILEDTH AL (Default
Text) IDEFERIMNILTHERTHI7+V N ERSN, TODIMADZ DT R T
DI+ BE BEUXFREAAIVIZEBLEZ 742 MBI EHANET,

TAURREALIV

TAURRAA L EEHALT, Dorico D&EBTHFRMNREDNBREERLET, 74>
FRAAILIE, THRRARIL—LIZAFLEZY, [Shift] + [X] OTFRMY—ILEFERL
TEEICEBEANLEYITETIFRAMIELODNIERZPLPXFDODARAEAILTIEHEL, T
. TURES. VUV RDORICRET HTFAM BEBEGLEICHERALET,

SEIFLHILBRIAINPIAL (R HF. PPOKRFLELE) OT+URT7R) %,
[7%%& (Engrave)] » D42 FRBA)IL (Font Styles)IF 4705 TEIRTESDLS
[ZHYZELE=, ChIZEY, FAT R0 12— 48— LD HLP BTV DI TAROR
RANEBRGEDTATLICHERTEET,

BWLWA—23 0 THERLI=TRY o ERIKE, Dorico (#IRLI=7A 2 RDR—ILE,
A3) 9 FT[ER—ILRAR) I DRAEA I EERT 5=DITFEHN TN KFT
ST ERAKRTZTEH. ZTDITAVMIRBEITAERFAIITIIEL T LESELFE
T RID/N—23 Tl BEICIKERTELRW IO I AN ERIRT B, AR
L—TAV T RT LN IAVRRFAIWEERLTOELED ZLDGEERXZINE
(BYFEHATLE (FEAIE KFEDQIIA N FERTELRWMESICAEDL T3
VEERTBE, BRICIECTRFOIAVIDERSNTULVELS), &/NN—2D30T
FHENTASIIRD IR AL VERATEGRN T AU DA BEREN -5
B L¥AS—FE/ =IO/ EMDYICERTILIIEESINET,

Windows & macOS TlE, 74V bDIBEAENKECEL D10, (FEALHH
ENBRNZEITFELTLESLY, Windows TlE, 7R ARER A2/ IILD—EH,
LXas—. 432V v 0 R—ILE R—ILRA By I DHEHELTEY . HERR 2L
DIAVMIFNDTAUPELTAZ A —IZTRTREINET, fzEZ (X, Adobe @ Minion
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Pro 4 rDXEMEIZIZILFa5—EEMEK (Condenced) MY, Windows TlE

AD T+ kT72)— (Minion Pro & Minion Pro Cond) ELTRRESNET, —
7. macOS Tl&. Minion Pro D&% T4V ME 1 DDITAURT7I—ELTER

RENILERRZAILIELF2T7— 4Ry R—ILFE  R—ILRA( Ry LI AT
[RBAL)L (Style)JA=a1—[ZRRENFET , Windows & macOS DavE1—4—
BMTTAD IO EBET HIH5E. 740 b DIRAZAIILEFERALTULVELAEREL

TLEZEW BELI=RAZAILAMERSNAS LI, BENED OS LTI VRREA

IWERETIDLENHIGENHYET .

AVARRSILAVNDEE

BROBREFDAVARYILAVL: THEBOBREFTOIVARIILAVIDE LD
MEAIERTIZTS (Allow individual staves of multi-staff instruments to
be hidden)] R—IUH, TLAF7 AT ay (Layout Options) IOTEEHRD AR
R—L24 (Vertical Spacing)lIZEEBMINhFELIz, ChIZkY . B—DEERZFOA
VARG VAN EBHDEREF DAV AL AV DHAEDLENTL—V—IZE|
YETONTWAIEEICERANERETFERRICTELRIITHYFEL -, FHILLVAA—D
3> Dorico TlE. EHDEREZFOIVARILAUID 1 DU LEDERIIER
RITHESTWSGEE . BEAENINTOSERIZITHARIINS O, ERHNSEL
HHEEDE/RANDEEEHERST ZENTEET,

INVDEEME: [ERONADTATLOLDSAVZARSILAVEDEESNIL
FETOm/MERME (Minimum distance above items outside staff for instrument
change labels)1A T av b, [§EA T3> (Engraving Options)IDTAV Rk
BILAVRDZERE (Instrument Changes)IR—UITBMENEL =, THIZKY. A
DARRGIAVRDEBINILHERD LICIEAE T AT LICE>THLEIN5
BICHERTHIEEARDOMBREHRETEET,

F—FR—FLa—rhyhk

MIDI F—R—K#%{#EHAL T, Dorico DAY RERETEDLSIZHYELz, a7
FEF—HR—F a—rhAvhIBRETRICIE, TODI IR TNS I EETEEL.
MREH[TE (Preferences)IF (7RI ZFHNT, [F—FR—FLa—rAvk (Key
Commands)JIR—CE#RRLET . AR MIDI M)A —ZEY L TEHHB A,
IMIDI Learn &%) yYL. A RIZRYEV T SELEHROHMBTLERTHH. K2
A0 yREMMZE, TMIDI a<UF%EEMN (Add MIDI Command)1&49) vy L THL
WA —ZRELE T, O—4)—arbO—)LETdz—4 —(F BEYR—FSNT
WEHA,

FAEDHAR: C AOv—0 A YA F—LGEBRBFILEEDLRVAS O, BRARDITS
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HLOFTFaIULHENTADIIRT, C A0¥—0 A IMFT—BEDF—~DEx
M. HARELTRREINDKIIZHBYEL ., HAREERRICT BIZIK TE2—
(View)] » THAF (Signposts)l » TEAF (Key Signatures)1&#42IZLET . i
BORELEEORED—FHZIAE—TURR—XLTBIZE, AEERRLTHDE
RITDBELHYET,

BAGERASDFTFI)l: BEICELT, FFaIL DR SEHNGRSZIEM
TEHRIITRYFELL =,

e ESERTTHHER (Systems on which verse numbers appear) 1473
UM, T#EA T3> (Engraving Options)IDTEREE (Lyrics)IR—IIZH B
FES (Verse Numbers)1¥ )L—TI2BMEhEL-, ThiKY ., TERABSE 1
BB OBFADRIBMEIZOARTT EM BERDLIICTRTOMBRITRRTS
NEIEETEET,

MIDI D AH

AVARSILAVEDEE: MIDI 74 ILD RSV IERHAALTZEED A A YL A
UhADTYE VT DKRIBICRESNELT=,

RSOEE: FROTaL—2avDEMAANKIBICHESNEL- LEDER
PRBEE, BOTREWNMAFICRDERCOBETIIAK BEL-EFELTREESN
FY, F EFORHERELLRBIZHESNFEL,

MusicXML D SiAAH

[MusicXML DEkHAH (MusicXML Import) IR—U W IBERE
(Preferences) 1% 47O IZEBMEN ., MusicXML 7/ ILEFHB IO IMEL
THRWzEEP BEFEOTODIVMOFHRIO—LLTHEARALZLEEIZ, EDTER
FRETOINEERTEDLSICHYFEL,

ChIZkY ., FHERET Dorico MNREFT DIEMMNDLRLRYELT =, FARBIGIKRRF

(EERARAFELZN O KTV IL—TIZIE Dorico DFEAZRENMERINFET . F=
BARMGERRRESLHRARAELZEVDT, EOEFRICEREELESERTT AN TEBES
NBHEEA TLaVICE o TREVET  BEILT AL —2avEBmHRAET . BEH

EEDISITBATORSMNIBESNDREEA T avITE o TREVET . KFD

MELHARATLEN O KAFIBESNDEEATLavITioT, FERICHLT

HEHICEEESNFET,
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FET—ay
[ (Edit)] » T8 (Go To)lHTA=a—hmEBEmMEhEL , T AZa—ITIF,
TOCIHMREBET 5O DERNLZITURLAHY . IMIIZEE) (Go To Bar)l
(T 74D F—HR—Fa—bAykE, [Ctrl]+[G] (Windows) FfzI&
[command]+[G] (Mac)) Z#FEIRT HL. TADCIMROVNT AL DTA—(ZH S/
Ry TEEI, =, BIDTO—(ZFE) (Go To Previous Flow)]®IRND70O
—IZ#%E) (Go To Next Flow)1Z:#IRT 5L, BIDTO—PROI7O—IZHREITESE
ED

EFDOAAN
MIDI F—R—FRIZ&DANIIHTERIGDSLICHRRELGYELz, F—FKR—F LT
BRI DHIEFE. ADLTHL—ENHKHEZEVNTEAINSIDTIILEL BELICH
ESNFT BESNLIBERIE. EFOEREZANDICHAT SHEL. [FEHE
(Write)] » TEYFDAA (Input Pitch)IA T2 a> DREICH->THIAT HIGEN
HYET,

BFERDAR—IVY
BIN—S3  EIFERGDI I, THEEA T3> (Engraving Options) 1D
FRDAR—L Y (Spacing Gaps)IZHATBEYES) X LT AT LB OR/INEH
(Minimum distance between adjacent rhythmic items)J[ZEBINENELT=,

INET.COA T I THRETHEIL. ERMNEFERLGVLDOTLZ, ChiE. E
MAR= 5 ASLDERDSRDAR—L 05 ASLOERMFEFTERASINA T
=TT, FEAETRTDAR—L VT ASLIZCORIMEEYEBDIEWNT 14T L
(FFEELE) NEEND=H.BYES 2 DDTATLDIEEHIIERIZIZFAR—ZAD
20 7D 1 BED/PNSGEELLY . Eiid 53T LM EMLTLDEIITRATLEN
F9 . &, BRNIMRLICEFRICRESNTWSIGEELEICHICIREIIGYE
E

FLON—2aoTREDEREEANAR— VT LOERNSRDIT A
DERETEGY . MR LICRFBICRESN-BERGEDERT 57 1T LA M
LTWAKRIICRAGHEYELL =,

I ay
REDATLIVEREEFRITOAD UMD T IHILNEEELTHRET HHRIU,
TLAL7 AT ay (Layout Options)l. NEEEkA 73> (Notation Options)].

EHANTTL 3> (Note Input Options) ). [#EF T3> (Engraving
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Options)l. TB4EA7 3> (Playback Options)1® Dorico ® 5 DDA T3
UEAT7ATITEMESNEL,

SEDOTYITT—MI&S T FAT7AY THREEZERLIEE. HEITH-TERE
BWELIKGS BB ICRTFELIZT IAUMEEIZRLIZY., RELIZT 74 LNERTE
FEGBLTHEBOREICRLIZYTESLSITHYEL ., £z, §RERTET
AT YMITIBEFRFORENERIND&SIZ. RELEZT I7HILREEHIR
TEBHESITHEYELS=,

F= . RELETI24ILREEICUEYE (Reset to Saved Defaults) I7R22 A3ETL
GEMEh., BFA4T7OT D TFEIZH DRI N—IZRTEINDESITHYELTz, 54
FOJIZTIANMEEERFELTOEWNES L, A2V K THEROBREIC Yk
(Reset to Factory)JERTREINFT , T IHILMEEZHRFELTLSITIE | TiGH
FIEDRTEICRLE=WLMES. [Ctrl] (Windows) F1=IF [command] (Mac) Z#L
t=IREETHRELE S ILET . ((Ctrl]/[command] Z# 3 &, R2 2 T HETR
DEREIZUEYE (Reset to Factory)JIZZEDHYET,)

BRELI=T I74ILNREZHIBR T A5 A . [Ctrl]/[command] Z#3 EMTI4ILREL

THR%EF (Save as Default) IR2> DR TN RFELIZT 74 LR ERELHIBR

(Remove Saved Defaults)IICEHLYET , RIVED VDT DL REFELIZTIAIL
EHELHIBRENET,

s
MRS (Ornaments)l/SRILDM/ OyHEH R (Baroque and Classical) ]t
DLAVIZRIRSINDT I7HILEDEMEDRZRIMNETIESNELz, SChETIEILTY
RIEREEN T wv B8 Toa—RRJILIIZEREN, TTIILR)S—1EFE IR TL
f= a D TEBILTUMIZERENFELT-, (STEAM-5849)

ffzsl\’fhz EEER. ROV aSM477— V=TSO DEMTEOND LY — K

EEEFDIZHIZ, J.S.7 v/ \D[Clavier-Buchlein vor Wilhelm Friedemann Bach/]
’Cﬁ#’)/‘né LA AT (Ornaments) /SR ILDM/sOvSEHEIR (Baroque
and Classical)] 27 avicEmEnELr:,

R—ILALTIk
R=UBTIL—LFZEIE— YRE—AR—CF{FETHHEE. TRI—R—ITT
13— LEIZH DY —ILN—DIL-RIFIEIR<LIREZVED)v LT, £l
DR—=UWLERIDOR—T  FERRDOR—UNLERDR—ALALT I E
AE—TE5KIITHYELT,

EBIT LATIMADMDR—U(HEIRL-IL—LEUTOFIETIE—TED
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FIIZHBYEL,

0 FETFOEBADNRIVIZREENEITIL—L (Frames)ltoiavn L
EIZHBIRAIFED)vIL, IL—LREY—ILEEMLET,

& MDOR—UICOE—F % 1 DFERIFBEHDIL—LEERLET,

o ERLEIL—LZFIE—FTEHER—T%F  ARIDIR—T (Pages) /AR JLTER
LET . [Crl] ZILENSD) I T EHEERDR—UFEIRTEEY,

® [R—=L (Pages)I/\RIILEGD)YIL, AVTFRMZa—%FRRELET ER
LI=L—LZERBIRLI-R—I(ZaEF— (Copy Selected Frames to Selected
Pages)]Z#IRLET,

R=TCDEBEDEE: BEET—FDIR=T (Pages)I/\RILDBXAR—DEIE
LU, BRULE-BER—SDIEFEZHET EIEADR—DEANBA-YTESL
ITEYFEL = BIRLIAR—DFREBENIT HIHE . [R—D (Pages)l/\RILE
BOUYHL, AV THFRMMZ2—SIR—=UDBE) (Move Pages)1&5')voLT
RALZ 4705 T BRULR—DZMR—DORTEIERAICEE T 50 FEIR
LFET,

HRDAR—UTOBEERBREEMNL: EREMBEOMBNILLT IR T ay
(Layout Options) I THEEL-BREMNSHBEINGWNKIIZTHICIE. TEEAMD
AR—L 2 (Vertical Spacing)IR— DI &/ME (Minimum Gaps) |93 av(c
EmInf-lNEYE58KREAMBEDEHERELBENICAEHE TS (Automatically resolve

collisions between adjacent staves and systems) |4 7> ar &4 2(ZLET,

MR A REDHE: HERZMIRRIAICT HLFIC. Efnd SHEBEDOMRMNERIZIL
A7 AT 3y (Layout Options) IDTEEARDAR—I Y (Vertical
Spacing)IR—U THEIN-BEOMRIVERZEVNEEET H5LI1TGYFEL,
FEAEEELYKREVGE (. BROIEVEERICAR—XZEML. £AMIZKY
B—[CRREINDKIIILET,

BAEPOEEER: FHLLVA—2300 Dorico Tl EBEE—K., SREEE—F.
HEE—FTOBERIZ. BEANYRNBICRREINAISICEENBEFMICFHE
BLET,

VST 2.x 75542 VST 2.x 545 4% Dorico TERTEDKIIZRTARIR
MZZEFT2EE2DTOEANERIEESNE L=, £3". Dorico DA A+—)LIZ[E
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WENBTIAILED vst2whitelist.txt Z7AILDIEHIZ, Steinberg FBED VST
2.X TS50 A % RAMZEHLET, ShikY, Dorico 27v7T—kLIZUBAY
Ab—ILLIY T B EZICLEZTINGVI—TF—EHDHZAHND 2 DHD
vst2whitelist.txt 774 I)LEHRARAL TENTEDKIIZHEYELT=, Dorico ZFEH)
THE TIFHILNDERTANI AT 7AINEA—F —EBDERTARN AT 7LD
BANGEARAEN, RTARRNMIEZINZT ST AV DYRMMEREINET,

FIAIRDERTAR) ARZZEEFSINTULVERL VST 2.x TS5 A4 Z 5 LI-00N\5
Bl 2 —F—pMERILT= vst2whitelist.txt 77 AILEFLLTDEBFFIZCEEZET,

® \Windows: C:
¥Users¥username¥AppData¥Roaming¥Steinberg¥VSTAudioEngine_64

® Mac: /Users/username/Library/Preferences/VSTAudioEngine

E5[2, vst2whitelist.txt Z7AILICIE, RTA RN EEET D VST T351>
DHEIRF (Windows: .dIl, Mac: .vst) ZBRWNM=T7AILBEEBML. T3T 104
ETFXRNIFAILADOEITIZENT B TRGYELT=,

SEEEE MHELE: Dorico IZRIMEEN Tz HALion Sonic SE 5475 —TI&, 58555
SDBEE (HVI7+2 . BB, TDMEEL) [T VST Note Expression ZFEHASN
TWELEM. TIAILLT MIDI arbO—5— 11 (Expression) AMERSNDES

[TEYELIz, ShiIZ&Y ., SEBREBIN TS 7 YT T—hT VST Note Expression

NYR—rENB K324 DHET, B EIL MIDI avbA—5— 11 THEIWE

ER

BRI

BEREEEER: FrLybkhRREINTIKET[Shift]+[P] ZHLTRIRINDRY
TH—"—, F=EEEBE (Playing Techniques) /3R )LD SEEREEA
NTESELIICRYEL, BIRUERREE, EROMNE TG OBRBEZA
h9 5L CITRTRSNET,

BMOEERE: T¥—HKR—F (Keyboard)Jt¥¥3>® m.d./m.s. (X—/- TRk
SIR—/ = RD) [ EERR (Brass)| 7 avDTXFAMeX D HE@EIa—bk,
08 (Choral)ltvParvmar -Ryh-Fo—4 TKREEFZ (Wind)Jtoar
DIT.IAVTY F—=IVvoRE FILLEEEENFHFRIOD /I CHERTE
B&S512HYFEL,
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TRNRTAIRIILDT—fE (Common) 1T IL—TI2&HBTATHEYE Y (Offset Y)17
ANTAZEFERALT BIRLEKRFE L TICHMAR TESLSITHEYELRZ, TANTA
T FEET—FTOARTINFET  (TRAFDIGEE . AU DRFDOANL TV

(1))

HEERIT A REIBARESNTODIGRICBEYET . AFE 1 ARN—XLU

ERBIEZ5EE. TBEFEARFF (Notes and Rests) 1T IL—TDIMAFDLE
(Rest pos ) I17ANTAZFERALET . COTONTAEFES L. (FRIFARFII—FE
WRAR—=R[ZRFYTLFET,

2R

2 DUEDTATLNERTRIESNTLSIGS . [Alt]+[Shift] ZHLGEALI)y
D9 BIET. PTATLEREITEIRTEDSISITHYFELE,

AT—
°

[24TOEAN=-ZH (Tied Notes)17 IL—TH, [EEF T3
(Engraving Options)IDIRS5— (Slurs)IR—IITEBMENFELIz, ShIZKY.,
RAS—DRBFERIIFELLMEE . FADOENY DRDEITREDZTFIZHE
ETEDLIINTHYFELZ, BREITELTI A/ DDEMYTORRAE (Start
pos. in tie chain) ]I/ D2LEMRYTOHOHTHIE (End pos. in tie chain)l
HERETDHLET. A=A TLavDREE LEETEET,

GEH T IL—TOREOELLIEEDS, FERDDETEHDHRF— (Slurs
starting on the last note or ending on the first note of a beamed group)l
ATaun, IEEA T3> (Engraving Options) IDTRS5— (Slurs)jR—
CICRTEINBMRIGOEIE (Endpoint Positioning) 17 )L—FI2BMEhE
Lfzo ShickY . RIGDEEZ . EMEMRIRLIZIGE LRKRIZTHH (RS
—DRImEFEDIALICERE). NI HIIHFELRARICTHD (RT—D# iR
FREDRIMALICEE) ZHEETEET,
FETIFTRI—D—ADHDUEEZYIATHET S5 . BMIZXS
—DRIFDHEINT D TIEAL [AlY] ZHLEASAS—ZENTE RS
—DREHBFLI-FEBRHTEET,

[RS—DEXAE (Maximum angle for slurs)1ht, R5—D T DRV EHK
ZOEREOAETIELE KFEDRT—FREIZHEHINDKSITHYFELT:,
- [#REF-CRAT—DORKXAE (Maximum angle for cross-staff slurs)]
AT avhBmEnELiz, COATLaviE, R ETLIYXRELAENERTE
SNTWET,
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fﬂéi% )L
HRINILDOMNWHEBROR/INTUR (Minimum indent for systems with

staff labels) 1A T3>y, TLA 7o hATF 3> (Layout Options) DTl E4AE
(Staves and Systems) IR—(ZBMENELTz, ShIZKY ., MRICERSNILER
T ALIITHRELTNDIGE . RBEDOLWVGERSANILOIEEART TSIV THRET
HEDNSL., EEONEVWANREBROAV TR LTERSNKSIZHYEL =, 1 B H
DHEBEDIZE. 7R—DRADHEED 1Tk (Indent first system of flow by)]

THRELEICRLTIOTUMGBMEINET , ShIZkY ERINIVEEELTH
EHAEDA T —IZHEYET,

HoEd
[HRRLDFERY A X (Custom Staff Size)IFA7RTH., TRE (Edit)] » IR
YA X (Staff Size)JHTA=—a—ITEBMENFELz, ShIZKY, TL—FV—IZET S
EROVAXEEEDEE (N—tUh) TERTELLIILGYFELI HEDTL—
—DERVAREERTTDIHFEE. TL—V—DERNTERFIEHNEEERL.
FAT7OTERRLET,
Custom Staff Size
Default staff size:  4.96pt staff = 7.0mm staff
Rastral size: |S'|zeS{6.0mm} v
Scale factor: %
New staff size:  4.27pt staff = 6.0mm staff
47T DIABDYA4X (Rastral size)JA=a—hmoT)ybDH 4 X%&IRT
oM ARZLDEFREN—L T —OTHRELE S, RO A XL, TRBEE
(Preferences) DB T 2E#EB AT (Preferred unit of measurement) I T E
LIzt DERICEFMTRREINET TOKIZ Vv ITHE TL—Vv—mEHE T HE
BIIBTEIITRTOERDY A XD EHEINET,
TXAk

BT Xb: TREEE (Write)) » THHEBXTXRME4ERL (Create System Text)I(7T
AR D L I—R b [Shift]+HAI+[X]) Z&IRTDE TATOLATIMTTF
AR AT LEERTESLIICLHYEL . LT F RN AT LK. TLLT IR
#7343 (Layout Options) DI FL—— (Players)IR— THELI-#EA D
CIVPDREBIZRTINET, T EICHHET 5T FRMI K> TRARFH S E
SNET,

44 R—3 Steinberg Media Technologies GmbH



O steinberg

IN—FLAT 9D TN AR EEBEAZMIEFERLT. REIZHELTR—SLA
T ILDY A XEERIIEE TEHKIIZHYELT=,

BFES

HFESOEA: HBAE—FEFVICLTIHFRSEEMT D&, ENLUBRDEFEE
SOHIBFAREASH, TR LURTO/NENEIZELDRSICHFSNET,

HEAFEESO/NER (BR): 1 NEHICHFRESHAERFET HESITHEHEF
RESEERMT BIHE. [Shift]+{M] IR ERTRENDRYTFH—/—T, INEiZE /N
EifR (B#R) TRUBDMESIHEERTEDLIITRYFEL =, INIRERTT BICIT,
FMFRSEN | | (7)) TRYY, ERTFICTHHEENI(TAY) ZFEALE
9o BIEL T, T4/4|3/41TIXINERERANFR RSN, [2/4: 341 TIERFREINFE A,

M=oY
THXFARNIL—LADOHEDNDTIOA—ICHIET Hb—I & FRATESLIITHYELT,
fLZE.3FEOHDTO—DRAMILERTT HIHE. {@flow3title@} Db—Y % (E
ALET  F—IUICIBASNSE S BREE—FDOIT7O— (Flows)l/ )L THEER
TEFET (B70—ICH BT 2TAVIDETIZ, ZH—DBEESNRTINTVET),

EFF
[R{ET5EH (Repeated Tuplets)1F IL—TH, IEEA T3> (Engraving
Options) IDMEFF (Tuplets)IN—IITEBMEINFELT =z, &t T HE— DERFIZx
THENDOLEOHFEINEZ BBMICERTRIZT 54TV aEIRTEET E/F
ZERRICT BT IRICHEABS LU EDERELIERN (Successive tuplets
of the same unit and ratio) 1%l L ELAFEIIEIER T (Hide ratio and
bracket) ISR ELET . BRI MHELAFINEZIERTICT IR RETHEHFD
# (Number of repeated tuplets before ratio and bracket can be hidden)]T
BELLHBIET L. ERDOEELRETHERNERRICGYVET  [RETS
EHEIERT (Hiding repeated tuplets) 1A 7L 3> Tl BHRD/N\I—UIZEFE
NTHEWMAFFP, BFICKYRET HIERDNI—UDKTNIIGEHEIZ, ERE
ERRODEFITTIMNEEETEET,

1—H—f5—T—R
® [Ea— (View)] » TX—L (Zoom)] » THRBLDOFRRMERE (Custom

Zoom)|F A7y hBMENFEL, F—R—Fa—rhyk& [Alt]+[Z] T

Dorico /N\—U 3 R 45 R— Steinberg Media Technologies GmbH



Dorico /\—2av BRE

O steinberg

T o (RT—BAN—DRIEDA—LLANIVERTT DRI DHEIZEHZ/IELN
BRIRBET7AIEVIVILTRTT DL TEET,) COFA7RTEFER
ToHE HoWIERICRBER—LTEHIENTEET, [Alt]+HZ]EHLTH
A7 %ERRL A—LLRIVEAANTEH ., LREIOTRENZFE-T,

5% BN TIREDRA—LLAN)LEEFHLET, [Return] WL T. EFEHE
ELET,

NURY—)LDZEINRESI, BE L TEREZBEFLTLH ERIPEESAY
BEYFELz, ThIZKY N\URY—)LEHERLTRAEDCE 2 — DN T:ERIEEE
BT ITBHIENTELXSITHYELS:,

BEICRALTWS T A I ERAUGEEIC. ZOTACIIMIET 51 RN F
BICRIRSNDESITHYELT,
15—EBYT—EREFZEEHRTEIRN—N, KEE—FODHMFYT—D&
#®IZBMmMENFELI=, Dorico ® 5 DDE—FDHARYT7—%35—ERS
HBEIX. TAIVT (Help)l » THAREY7— (Guided Tour)1#RIRLET,

94> K™ (Window)] » TRIMDE—K (Previous Mode)lA=a—A%EMNE
N, BEDE—FEAELRERL-E—FZREUIYBZ OGNS LIITREYELE,
KYBLTOERTG51=H12, BREH/E (Preferences) I TTOBREIZF—R
—Foa—bhvbEEY B TEHIELTEFT,

B FE-XEEBE—FHORATDF TV )y TR/ E—FICUIVEZS
(Double-click in Setup or Engrave mode switches to Write mode)14+ 7+
avhs, NRIBRTE (Preferences) DI 2 (General)IX—TIZEMENEL
fzo COATAVEATICTHE REET—FEITHFEE—FTEHATL—L
REZTILI)YILTHERDANETEIRET—FIUVEDYFEE A,

BEEROIL—LRE (HWE (Edit)l. [L—L%ZHEE (Edit Frames)]).
ERDAR—I VY (T#F (Engrave)l. [BROAR— T %RE (Edit
Staff Spacing)l). BRDAR—L 5 (TR (Edit)l. [BEFOAR—I2YT
¥R (Edit Note Spacing)l) ® 3 DDEHLEE—FIZ, F—HR—K3—k
AVREEIYHToNSKIITHYELT,
BEDIL—LFI—UICHEREICOHKELSERASNDTO/AT4H, Fv
L—Ea1—TEELZRTITDIEFEASNTNDLSICRZTHOHLMoT1Z

O "RREHRELELT,
TONRTAIRRINOF T3 FAT7OT DINREICRAR—RER RS DIk
A—I)LONMHRELTIVT () ZFERTESELIICHBYEL,
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ROATavh TRk (Edit)] » THEE (Voice)lTA=a—IZEBMEINELT =,

o EHONBEANEZ (Swap Voice Contents)1Z#EHAT 5L BIRLES
FONMECTHEATIFMEANBRLIENTEET,

o [Fi%#ZHE (Change Voice)lZ AT 5L ERL-EFPOMBITHEHRTS
EHEEETEET, BICERTHEALTWSEEE) AMIRRL (BIRLE-E
FEMBX. ZOEMOREOERLEMBIIT—USNFET)  BEISELTE
FEFROLAZFELZETRAEZHEOFIBICERTEET,

WINDOHmEEED. RICERUL-ERICOAZELFTT  BROERHOEFL
ZERLIZIGETH. BYDEROEEICITZELEE A

SEIS FILTD 2 DOFEEORMEMBIEFZEERL, FBEFIEIFEDELSH
[CEHETEMEZRE CESHERDIEEEANEX (Swap Voice Order) 1A%,
MR (Edit)] » THR (Stem)I¥TAza—molERE (Edit)] » TEE (Voice)l
YIAZa—TBEIShELT

INTH—IR

BEE—NTOTO—DHIBRE LB A KIEIEGYE L,

A2V A—=)L

Steinberg Download Assistant M5 Dorico 4> A—Rg 5&, Dorico MDA
DT TV r—3v A Ab—F—_ HALion Sonic SE T35 /4> LarT7Y,
HALion Symphonic Orchestra a7V ® 3 DHMERIZEEEINSKIIZHEYE
L7z, HALion Sonic SE % HALion Symphonic Orchestra 4> Xt—)LEHD
BARTH. IS M0aTIVIZRERT YT T EENTOLSATEEEN H D
1= . Dorico [CEIMRENAAVAR—F—F TR TEITIAIEEZHEITITOHLET . A
DRAR—IVBFIZIE AT LEDAVTUYDEREHSTZOIZ, AV RM—ILEHD
NBEHZELTHSTYI T TEONET,

NI a—F14245

AT (Help)l » TEZELR—FD{ERL (Create Diagnostic Report) 1A 73>
ALBMEINELIz, CDFA T 3>%:EIRT HL. Dorico Diagnostics.zip ELV54
BIDT—hATDMEREIN., TR T IZREFESNE T, 7—HATIZIL. Steinberg
DAZYINEEZEZHL. KFYRRICFERT S-OITRIDFEBAEENTNET,
Dorico DFEASPICHEMMLERHE (TIV7r—2av ORERTOA—T14ELU
BETNARADOMBERE) BREELTHR—IAERKLIZY, I—HF—T+—F LA~
BRZEBELEYT BEIL, Dorico Diagnostics.zip 774D FFE SRS
Ly,
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ID # Component Issue
A ] Copying and pasting music with arpeggio signs now correctly retains the arpeggio signs in
STEAM-5488 .fPeQQlO pying p . 9 peggio sig y peggio sig
signs the pasted material.
A ] Arpeggio signs are no longer incorrectly removed when using the Change Instrument
STEAM-5549 ‘fPGQQ/O peggio sig . 9 Yy . ¢} g
signs feature to change one instrument held by a player into another.
A ] Adding a cross-staff arpeggio sign in situations where either or both staves include notes
STEAM-5800 99’ necing & eros pegglo =19 | ,
signs in multiple voices now correctly creates the arpeggio across all voices.
. . Articulations no longer incorrectly avoid ties that are on the opposite side of the notehead
STEAM-5896 Articulations ) )
to the articulations themselves.
Bar numbers drawn at the start of the system no longer incorrectly move horizontally when
STEAM-5118 Bar numbers .
a start repeat barline appears at the start of the system.
. Special barlines no longer show a redundant time signature signpost if they do not also
STEAM-5332 Barlines . ) . .
coincide with a change of time signature.
STEAM-6172 Barlines Start repeat barlines at the start of the flow now draw as expected in galley view.
. Adding a barline (e.g. a double or start repeat barline) with an existing barline selected no
STEAM-6224 Barlines )
longer causes the new barline to be added one bar later than expected.
Adding bars via the Shift+B popover now correctly considers the prevailing alternating
STEAM-4768 Bars . ) .
time signature, if any.
Deleting bars via the Shift+B popover now correctly considers any ongoing octave lines,
STEAM-5705 Bars . .
lyrics, and grouped dynamics.
When deleting bars via the Shift+B popover, a time or key signature at the beginning of
STEAM-6163 Bars ' . . .
the first bar to be deleted, that time or key signature is no longer deleted.
If the caret is positioned in the middle of a bar when deleting bars via the Shift+B popover,
STEAM-6267 Bars : . . " .
the bar in which the caret is positioned is now completely deleted.
Bracket d  Creating, deleting or otherwise editing a player group in Setup mode now correctl
STEAM-5592 ey 9 9 . 9Py . N p P g
braces updates the brackets and braces in the score immediately.
. The handles that appear in Engrave mode for hairpins have been improved, such that they
STEAM-4751 Dynamics . .
follow the mouse more closely during drag operations.
. Cutting and pasting dynamics that are part of a group now works more reliably, with the
STEAM-5295 Dynamics .
dynamics offset correctly when pasted.
STEAM-5295 Dynamics Cutting and pasting dynamics that are linked together now works more reliably.
Using Alt+click to repeatedly copy dynamics no longer results in duplicate dynamics bein
STEAM-5761 Dynamics 9 P y copy sy o P Y o
created.
. Dynamics at grace note rhythmic positions now track the mouse pointer correctly when
STEAM-5971 Dynamics

dragging them in Engrave mode.

Dorico Version History
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ID # Component Issue
When entering dynamics into the Shift+D popover while the caret is visible, advancing the
STEAM-6123 Dynamics popover with Space will now correctly only extend a hairpin if it was the final dynamic
entered into the popover.
STEAM-4813 Flows Adding more than 79 flows to a single project no longer causes a crash (Windows only).
Attempting to set the Grace note before barline property on a grace note at the very start
STEAM-6169 Grace notes .
of the flow no longer causes Dorico to crash.
Holds and Fermatas on barlines now draw in the correct position relative to barlines on single-line
STEAM-5731 o
pauses percussion instruments.
Holds and Fermatas on barlines are now positioned correctly if the barline results from a local time
STEAM-5732 ) i n )
pauses signature (i.e. one specific to a single staff).
STEAM-5733 Holds and The option Gap to right of caesura in the Horizontal Position group of the Holds and
pauses Pauses page of Engraving Options now works as expected.
STEAM-6104 Holds and Reset Position now takes effect inmediately for a selected fermata, caesura or breath
pauses mark, rather than only appearing to take effect after another nearby edit.
STEAM-6117 Holds and A problem whereby a fermata over a barline could drift further and further away from the
pauses staff during editing in galley view has been resolved.
Holds and - . . . -
STEAM-6147 Fermatas positioned on barlines now break multi-bar rests in the correct position.
pauses
Inst t A redundant key signature no longer appears if the point at which an instrument change
STEAM-5644 o umen ey sie gerapp P 9
changes occurs coincides with a key change.
Inst ; Changing between a multi-staff instrument and a single-staff instrument no longer
nstrumen
STEAM-5686 " “ unnecessarily shows a clef if one of the staves is hidden because it is empty, and it shows
changes
g the same clef as the existing staff.
Inst , When an instrument change occurs at the end of a system, the required clef change and, if
nstrumen
STEAM-5757 h the transposition of the new instrument is different, the required key signature now
changes
g correctly appear.
inst , If all the notes belonging to an instrument in a given system have been crossed to another
nstrumen
STEAM-5758 h staff, and the option to allow some staves belonging to an instrument to be hidden is
changes
o enabled, the destination staff is now shown correctly, so that the notes appear.
STEAM-5765 Instrument A problem whereby redundant instrument change labels would appear during note input
changes close to the point at which the instrument transition occurs has been resolved.
STEAM-5777 Instrument When one staff of a grand staff instrument is hidden and the single staff shown changes
changes from one system to the next, Dorico no longer shows redundant clef changes.
Key It is now possible to add microtonal accidentals when using a traditional Western key
STEAM-4787 ) ) ) ) o
signatures signature, provided the current tonality system’s EDO value is divisible by 12.
Key Under rare circumstances, deleting a key signature on a single staff could cause a crash.
STEAM-6301 . .
signatures This problem has now been resolved.
Layouts whose names have not been explicitly overridden will now correctly update when
STEAM-5859 Layouts the instruments attached to their associated players are changed after a project has been

saved and reopened.
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ID # Component Issue
o Some key commands that were defined in the English version of Dorico but were missing
STEAM-5928 Localization . .
from the localized versions have now been restored.
o The names of font, paragraph and character styles are now correctly translated in the
STEAM-6221 Localization - )
relevant editing dialogs.
Lo When running in a language other than English, OS-provided dialogs such as Open and
STEAM-6289 Localization
Save are now fully translated (Mac only).
. In rare circumstances, dragging a lyric hyphen could cause Dorico to crash. This problem
STEAM-6268 Lyrics
has now been resolved.
. Lyric extender lines and hyphens now draw in the correct positions if they cross a system
STEAM-6269 Lyrics . . .
break in the middle of a bar, or in open meter.
STEAM-4171 MIDI import The detection and quantization of tuplets in MIDI files has been significantly improved.
. The Mixer window now correctly updates immediately in response to changes to players
STEAM-5285 Mixer . .
and instruments made in Setup mode.
Multi-bar Multi-bar rests will no longer collide with key signatures or time signatures at either end of
STEAM-6217 L
rests the bar when spacing is tight.
Multi-bar ) . . . o
STEAM-6347 " Multi-bar rests are now positioned correctly above single-line percussion instruments.
rests
Multi-bar A double or other special barline in the middle of a bar now correctly causes a multi-bar
STEAM-6369 .
rests rest to be split.
STEAM-4892 MusicXML . . S . '
) Numbered instruments are now imported more intelligently from MusicXML files.
STEAM-5807 import
STEAM-6089 MusicXML The Ends voice property is no longer set on the final note in each voice in an imported
import MusicXML file, which could cause rests not to appear when adding more music at the end.
L Navigating with the right arrow in galley view no longer sometimes fails to navigate onto a
STEAM-5706 Navigation
rest.
L Navigating with the up and down arrows in a single-staff layout in galley view will no longer
STEAM-5710 Navigation ] ) ] )
sometimes incorrectly navigate horizontally.
. Using chord mode to add notes to existing notes and chords no longer incorrectly removes
STEAM-1995 Note input ) . .
articulations that were originally present.
. Using Alt+left/right to move notes by the current rhythmic grid resolution now handles
STEAM-4869 Note input
tuplets correctly.
Inputting a rest by playing a note or chord on a MIDI keyboard with rest input engaged
STEAM-5234 Note input after having previously input a chord now correctly inputs a rest, rather than the note or
chord played.
. Creating octave lines, gradual tempos, and gradual dynamics based on the selection now
STEAM-5571 Note input ) . . .
always produces a line of the expected duration at the rhythmic start of the selection.
. Step input from a MIDI keyboard no longer causes a crash when inputting into a score
STEAM-5678 Note input

using a tonality system other than 12-EDO.
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@ steinberg

ID # Component Issue
Changing the order of players in Setup mode is now correctly reflected in the order in
STEAM-5805 Note input which staves are visited when you move the caret up and down between staves in galley
view.
Changes made to the order of players and instruments in Setup mode are now correctly
STEAM-5805 Note input reflected in the order in which staves are navigated by the caret during note input in galley
view.
. Double-clicking a note above the top of the top staff or below the bottom staff in the
STEAM-5950 Note input
system now shows the caret correctly.
Deleting a tuplet with an expanding ratio (e.g. 2:3 rather than 3:2) no longer incorrectl
STEAM-5952  Note input 9.8 TP panding ratio (e.g ) no long Y
deletes any adjacent tuplets.
| Moving the caret left now always correctly navigates to the nearest rhythmic grid position,
STEAM-6041 Note input . .
rather than to the last note in the voice.
Copying and pasting system and frame breaks, and note spacing changes, from one layout
STEAM-6234  Note input pying and pasting sy axs pacing ehang y
to another now retains the relevant properties in the new copies.
. Using a MIDI keyboard to input notes in a layout-specific music frame would previously
STEAM-6246 Note input ) ) .
ignore the accidentals played on the keyboard. This problem has now been resolved.
. Using a MIDI keyboard to input into a layout-specific frame chain (rather than the main
STEAM-6246 Note input : : . . .
music frame chain from the master page) now inputs notes with accidentals correctly.
. Using Alt+up/down arrow to change the pitch of notes in a frame chain with a player filter
STEAM-6319 Note input )
applied now works correctly.
When copying and pasting notes that use a different notehead type, the changed
STEAM-5812 Noteheads } ) i i
notehead type is now correctly retained in the pasted material.
It is now possible to set the stem direction of a note in a project created by importing a
STEAM-5843 Notes : . ) ) N S
MusicXML file directly, without first removing its forced stem direction.
. It is now possible to nudge octave lines using Alt and the arrow keys (or use Ctrl+Alt for
STEAM-5720 Octave lines )
larger steps) in Engrave mode.
. Under rare circumstances it was possible for dotted octave lines of a certain length to
STEAM-6078 Octave lines Lo .
draw as solid lines. This problem has been resolved.
Changing an existing glissando line from drawing with a straight line to drawing with a
STEAM-5878 Ornaments ) ) ) ) )
wiggly line now correctly immediately updates the appearance of the line.
Setting the Space size property on a system or frame break now results in the initial value
STEAM-4497 Page layout ) . . .
(of 4.96pt, equivalent to a 7mm/0.28" staff) taking effect immediately.
STEAM-5535 Page | ; Editing the Wait for next frame/system break properties for a selected frame or system
age layou
STEAM-5911 ge break now causes the casting-off of the layout to be updated immediately.
STEAM-5624 ) " . . .
Page layout Changing the order of frames within a chain of music frames now works reliably.
STEAM-5826
Deleting a flow in a project with multiple flows no longer sometimes causes all music in a
STEAM-5669 Page layout layout to stop drawing, if one of the music frame chains in the layout was set to show only

the flow that has subsequently been deleted.
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@ steinberg

ID # Component Issue

Under some circumstances, changing the vertical position of a rest could incorrectly cause
STEAM-5755 Page layout the staff spacing to widen, or dynamics to move unnecessarily. These problems have been

resolved.

Under rare circumstances, it was possible for Dorico to crash when changing the frame
STEAM-5819 Page layout . . . .

chain to which a music frame belongs. This problem has been resolved.

Inserting blank pages before the page containing the first page of a flow no longer
STEAM-5910 Page layout i g pag Pag .g . Pag , g

sometimes causes the start of the flow to be missing from the music frame chain.

Locking the contents of a single music frame containing music from multiple flows now
STEAM-5923 Page layout

works correctly.

Attempting to lock a system or frame with a system or frame break signpost selected will
STEAM-5930 Page layout

no longer cause a crash.

Lock System will no longer lock the wrong system if you select a clef, key signature, or time
STEAM-6151 Page layout ) .

signature at the end of the system to specify the end of the system to be locked.

After adjusting staff spacing, undo now correctly only undoes the last spacing adjustment,
STEAM-6311 Page layout . . .

rather than clearing spacing adjustments.

Under some circumstances, deleting an item that causes the casting-off of the music to
STEAM-6317 Page layout ) ) o ) L

change, then undoing that deletion, would not return to the original casting off. This is fixed.

When your computer is connected to wifi, Dorico no longer polls the available networks
STEAM-5760 Performance . . . -

every 10 seconds, which can in some circumstances result in high network latency.

When a note is partially scrolled out of view in the event display in Play mode, it no longer
STEAM-5963 Play mode ) . . L . .

incorrectly shows a border at its left-hand side, making it appear it starts at that position.

Changing the settings in an instrument'’s track header no longer incorrectly causes the
STEAM-6063 Play mode . .

event display to scroll back to the beginning.

A problem whereby the ports in the chosen audio device could become disconnected,
AD-244 Playback ] .

causing no sound to be heard on playback, has been fixed.

When choosing a different audio device in the Device Setup dialog, the list of sample
STEAM-4803 Playback ) . .

rates is now correctly updated to show the sample rates supported by the active device.

If you attempt to choose an audio device that is currently unavailable in Device Setup,
STEAM-4806 Playback Dorico will no longer incorrectly show you that this device is chosen, instead showing you

the device that is actually in use.

Articulations such as staccato, accent etc. now only affect notes in the voice to which they
STEAM-5553 Playback

belong.
STEAM-5718 Playback Short appoggiaturas before dotted notes now play back with the correct length.

Grace notes before the beat now always correctly truncate the preceding rhythmic note in
STEAM-5719 Playback

playback.

Short (unmeasured) grace notes that coincide with a change of tempo now play back with
STEAM-5727 Playback

the correct length.

Notes played as keyswitches defined in expression maps for octave-transposing
STEAM-5748 Playback

instruments are no longer themselves incorrectly transposed by one or more octaves.
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@ steinberg

ID # Component Issue
Measured two-note tremolos now play back with the correct duration for notes of an eighth
STEAM-5749 Playback . .
(quaver) and shorter in duration.
When multiple projects are open, the playhead now only moves in the project that is
STEAM-5756 Playback )
playing back.
The playhead no longer incorrectly jumps back to the start of the system it has just finished
STEAM-5837 Playback . .
playing before proceeding to the next system.
Hitting the button to rewind to the beginning in the Transport during playback now
STEAM-5407 Playback
correctly restarts playback from the start of the flow.
STEAM-5851 Plavback Notes with tremolos or arpeggio signs within slurs no longer sometimes fail to play back
aybac.
STEAM-5802 A correctly because of the Playback Options to humanize the start positions of notes.
After changing the endpoint for an instrument in Play mode, manually assigning an
STEAM-5982 Playback endpoint for a newly-created instrument would result in no playback. This problem has now
been fixed.
Players and instruments added to your project after you have overridden the VST
STEAM-5982 Playback instrument or MIDI output used by an existing instrument in your project will now be played
back correctly.
MIDI program changes defined as actions in VST Expression Maps are now output
STEAM-6072 Playback )
correctly during playback.
Program changes arising from switches in VST Expression Maps are now output before all
STEAM-6128 Playback . "
notes at that rhythmic position.
If you start playback immediately after selecting a note, that note no longer sometimes
STEAM-6290 Playback i
incorrectly holds on after playback has started.
Single letters such as | or A at the end of an instrument’s name will no longer incorrectly be
STEAM-5747 Players ) .
interpreted as a Roman numeral and converted into a number.
STEAM-4942 Playing Changing the properties of one or more selected playing techniques now correctly
techniques updates the appearance of the playing technique across its whole range.
o When entering playing techniques using the Shift+P popover during note input (i.e. when
ayin
STEAM-4943 ' ;‘:I g the caret is visible), the chosen playing technique now appears immediately after
echniques
P confirming the popover, rather than after a note has been input at that rhythmic position.
Playi Text playing techniques are no longer incorrectly scaled to a smaller size when attached to
STEAM-5768 V'Y praying feehniq 9 Y
techniques grace note positions.
When selecting multiple layouts to be printed or to be exported as graphics, all pages of all
STEAM-5389  Printing g mutipe fay >P P S 9rap Pag
selected layouts are now correctly printed or exported under all circumstances.
L. Rests are no longer incorrectly printed in color when the View options to show Voice
STEAM-5791 Printing L X
colors or Implicit rests are switched on.
STEAM-5561 Rests Setting the color of a bar rest via Properties now correctly updates the score immediately.
Changing the number of empty bars at the end of a flow no longer incorrectly causes the
STEAM-5701 Rests

tacet al fine multi-bar rest to disappear if shown.
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@ steinberg

ID # Component Issue
. Using Shift+left/right arrow to extend block selections now works in any music frame
STEAM-5680 Selections . . . .
chain, not only the main music frame chain from the master page.
. Select All now works correctly in any music frame chain, not only the main music frame
STEAM-6320 Selections .
chain from the master page.
Setting the End offset property for a single-segment slur no longer incorrectly also sets
STEAM-5746 Slurs
the End handle offset property.
It is no longer possible to create zero-length slurs (for example, by selecting multiple notes
STEAM-5832 Slurs of the same chord and hitting S), which can cause the placement of other items, like
articulations, to be incorrect.
It is no longer possible to create linked slurs across multiple staves that do not start and
STEAM-6134 Slurs . -
end at the same rhythmic position.
Changing the Staff labels paragraph style now correctly updates the appearance of the
STEAM-5101  Staff labels gng paragraph s yup PP
staff labels in the score.
Tempo marks are now correctly aligned at the start of a bar with a special barline but no
STEAM-4614 Tempo . )
time signature.
If a tempo item’s properties are set such that no printable text will appear (e.g. the text is
STEAM-5693 Tempo o ) i
empty, and the metronome mark is hidden), a signpost will now always appear.
STEAM-6113 Tempo Tempo marks are no longer sometimes incorrectly offset to the right in galley view.
Double-clicking a text item in Setup or Engrave mode now switches to Write mode before
STEAM-5552 Text . "
opening the editing popover.
Changing the name of a player in Setup mode now correctly immediately updates any text
STEAM-5856  Text R - praye P Y yup y
items in the score that are using the {@playerName@} token.
Changing a font style now correctly shows the effect on any styles that inherit from it
STEAM-5875 Text ) ) i )
without having to confirm and reopen the Font Styles dialog.
Time If a bar is split either side of a system break, the time signature no longer incorrectly draws
STEAM-5786 )
signatures at the start of the second system.
T The signpost text that appears for an aggregate time signature now correctly shows the
ime
STEAM-5890 anat broken pipe character that indicates the dashed barline subdivisions between the different
signatures
9 time signatures.
- The Pick-up bar of control in the Create Time Signature section of the Time Signatures
ime
STEAM-6020 nat panel now correctly creates a pick-up bar using the beat length of the time signature to be
signatures
g created, not a fixed quarter note (crotchet) beat length.
STEAM-5745 Tremolos Strokes on one-note tremolos no longer sometimes draw too close to the notehead.
The ratio for a hidden tuplet number shown in the signpost now matches the ratio that will
STEAM-5696 Tuplets . . .
be shown when the tuplet number is shown, rather than its lowest common denominator.
If tuplets are hidden by way of the options in Engraving Options, an appropriate signpost
STEAM-5704  Tuplets P ywey P graving &p ppropriate signp

will now always appear.
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@ steinberg

ID # Component Issue
STEAM-2201 User intert All items in Dorico’s panels now draw at the correct high-resolution pixel density on high-
ser interface
STEAM-1786 DPI or Retina displays. Previously some panel items were still drawing in low resolution.
. The Expression Maps dialog now correctly shows which expression map is loaded when
STEAM-5299 User interface . oo .
the dialog opens by selecting it in the left-hand list.
To make it clear that you cannot transpose up or down when transposing by a unison, but
STEAM-5517 User interface  rather can only transpose by a quality, e.g. augmented or diminished, the Up and Down
buttons are now disabled in Write » Transpose when transposing by a unison.
. Entering or exiting full screen mode by clicking the green traffic light button in the window
STEAM-5604 User interface . . .
title bar now correctly updates the checked state of the View » Full Screen menu item.
Key commands edited in the Preferences dialog when only the Hub window is open rather
STEAM-5614 User interface  than a project window now correctly take effect immediately, rather than only taking effect
when a project window is opened.
STEAM-5715 ) The Expression Maps dialog now shows the correct information for the initially selected
User interface . .
STEAM-6095 expression map when the dialog opens.
. The guided tour is now correctly triggered for the mode a project opens in, rather than
STEAM-5717 User interface » . .
waiting until the user changes mode to trigger the tour.
. The spin box showing the chosen channel in the track header in Play mode is now wide
STEAM-5793 User interface .
enough to show channel numbers higher than 9.
Under some circumstances it was possible for changes made in one options dialog to be
STEAM-5891 User interface  incorrectly applied to another open project, if the corresponding options dialog was also
open for that project. This problem has been resolved.
) It is now possible to use undo and redo (and other key commands) while a modeless
STEAM-5892 User interface . . o
options dialog is in focus.
. Moving the focus between the two panes of a horizontally or vertically split view now
STEAM-5898 User interface . . .
correctly updates the state of Dorico’'s menus immediately.
Changing the selected layouts and flows in Layout Options and Notation Options
STEAM-5901 User interface  respectively now always ensures that the option values shown in the dialog reflect the
current selection of layouts or flows.
. When you remove a player from a flow in Setup mode, you will now be prompted that
STEAM-5984 User interface ) ) ) ) . . .
completing this operation will delete the player's music, and ask you to confirm the action.
Some minor problems with assigning playing techniques in the Expression Maps dialo
STEAM-6135 User interface P gning piaying . P P ¢
have been resolved.
) Repeated key commands that include a modifier (e.g. holding down Alt+left arrow) are no
STEAM-6166 User interface i ) ) I
longer sometimes interpreted as if the modifier is not held down (Mac only).
. Dragging a tab from one group to another within the project window (i.e. with a horizontal
STEAM-6191 User interface . . ) . . .
or vertical split) now correctly activates the tab immediately after the drag is completed.
. Dorico will no longer crash if you attempt to undo with the Steinberg Hub window in focus,
STEAM-6206 User interface . . i ) .
or if the current tab in the project window does not contain a layout.
. Attempting to save default options from one of Dorico’s options dialogs will no longer
STEAM-6250 User interface

crash if the user application data folder is non-writable.
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@ steinberg

ID # Component Issue
. Enabling editing of frames, staff spacing, or note spacing, or switching back into Engrave
STEAM-6281 User interface ; . . .
mode with one of these tools active, now correctly clears any selection from Write mode.
. When deleting a flow from the Flows panel in Setup mode, Dorico no longer incorrectly
STEAM-6283 User interface o o ] .
changes the selection in the panel, making it appear as if the wrong flow will be deleted.
. Moving one or more players up or down in the custom player order list on the Players
STEAM-6349 User interface . o
page of Layout Options now always keeps the selected players in view.
. A problem whereby some items could move further and further away from the staff while
STEAM-5795 Views L N .
the music is being edited in galley view has been resolved.
. It is no longer possible to set a non-percentage zoom level (such as zooming to page width
STEAM-5926 Views

or height) in galley view.
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